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1. Benvenuti nell'help COPA-DATA 

GUIDA GENERALE 

Nel caso in cui non abbiate trovato delle informazioni che cercavate o se avete dei consigli relativi al 

completamento di questo capitolo dell'help, mandate una Mail a documentation@copadata.com 

(mailto:documentation@copadata.com). 

 

 

SUPPORTO ALLA PROGETTAZIONE 

Se avete delle domande concernenti progetti concreti, potete rivolgervi per E-Mail al 

support@copadata.com (mailto:support@copadata.com). 

 

 

LICENZE E MODULI 

Nel caso in cui doveste constatare che avete bisogno di altri moduli o licenze, rivolgetevi ai nostri 

dipendenti all'indirizzo sales@copadata.com (mailto:sales@copadata.com). 

 

2. Editor 

zenon consiste di due componenti principali, l´editor e il Runtime. I progetti vengono realizzati 

nell'editor dove ne avviene anche la manutenzione, mentre la loro gestione e osservazione avviene nel 

runtime. A partire dalla versione zenon 7.10, l ´Editor è disponibile come versione a 32-Bit e a 64-Bit.  I 

progetti possono essere editati alternativamente con entrambe le versioni.  I dettagli concernenti la 

compatibilità con versioni di zenon 7.10 li trovate nel capitolo conversione progetto, nel capitolo 

Versione  a 64-Bit. 

mailto:documentation@copadata.com
mailto:support@copadata.com
mailto:sales@copadata.com
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Nel capitolo Editorimparerete a conoscere le componenti base dell´editor, Vi saranno fornite delle 

informazioni relative a come lavorare con il  Manager di progetto (auf Seite 89), Barre dei simboli (auf 

Seite 27), Menu (auf Seite 56) e Profili editor (auf Seite 79). Trovate delle spiegazioni concernenti il 

menu contestuale degli elementi in un´immagine nel capitolo Immagini. 

  Informazioni sulla licenza 

L´Editor di zenon funziona solamente in presenza di una licenza valida. La licenza viene 

calcolata sulla base del numero dei Tags e IOs di cui si ha bisogno. I dettagli sul tema 

licenze li trovate al capitolo Licenze.  

L´Editor è a disposizione come zenon Supervisor e come zenon Operator Le due versioni si 

differenziano nell´ampienzza delle funzioni disponibili. Per i dettagli vedi Limitazioni per 

zenon Operator. 

SQL SERVER 

L´editor di zenon lavora con una banca dati SQL. Questa viene <installata insieme> all´Editor di 

CD_PRODUCTNAME. Per creare una connessione, l´Editor si collega al server SQL (zenDBSrv.exe) di 

zenon. Quest´ultimo instaura la connessione con il server SQL. 

FUNZIONAMENTO MULTI-MONITOR 

Se su un PC sono in funzione più monitor, i dialoghi, le barre dei simboli ecc possono essere spostati su altri 

monitor. La posizione di questi ultimi viene salvata e conservata al momento del prossimo start. 

  Informazioni 

Se, quando l´editor viene riavviato, non è disponibile che il monitor principale, è possibile 

che degli elementi spostati non siano eventualmente visualizzati nell´area visibile. Per 

riportare tutti gli elementi sul monitor principale, dovete attivare il Profilo standard (auf 

Seite 86). In tal modo, le posizioni vengono riportate ai valori standard. 

 

 

3. Avvia l’editor 

Per avviare l´editor, avete a disposizione diverse opzioni: 
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 cliccate sul simbolo zenon sul desktop del Vostro PC. 

 Apertura mediante il menu Windows File -> COPA-DATA -> zenon Editor. 

 Avvio tramite il Startup Tool. Esso consente la gestione di più versioni di zenon e la 

configurazione dell´editor e del runtime prima dello Start. 

 Per Windows Autostart. 

SERVIZIO ZENADMINSRV  

Per avviare l´editor, deve essere avviato il servizio zenAdminSrv . Se il servizio non è disponibile, 

riceverete il messaggio "L´editor non può essere avviato perché il servizio  'zenAdminSrv' non è 

raggiungibile!". Attivate il servizio e riavviate l´editor. 

Al momento dello start tramite Windows Autostart, zenon cerca di avviare per cinque volte l´editor e poi 

si ferma emettendo la segnalazione di errore che il servizio non è raggiungibile.  

 

4. Compatibilità: 

L´editor di zenon è completamente compatibile con le versioni di numero inferiore. I progetti che sono 

stati realizzati usando una di queste versioni, possono essere aperti e modificati in qualsiasi momento. 

Al momento di aprire un progetto con un numero di versione inferiore: 

 il progetto viene convertito automaticamente 

 viene creato automaticamente un backup di progetto 

 i progetti  convertiti non possono più essere aperti nell´editor di una versione inferiore. Il 

backup di progetto generato al momento della conversione, però, può continuare ad essere aperto e 

modificato. 

COMPATIBILITÀ FRA EDITOR E RUNTIME 

Con l´editor di zenon, possono essere creati i file runtime per diverse versioni del runtime. La versione 

del runtime, dunque, non deve necessariamente essere la stessa di quella dell´editor. Questa 

compabilità verso il basso è particolarmente utile se si intende utilizzare dei sistemi misti. Ad esempio: 

un progetto viene realizzato con l´editor della versione 6.50, ma può essere avviato anche con il runtime 

della 6.22. 
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  Attenzione 

Se in un progetto vengono impostate delle proprietà con un editor di una versione 

superiore, le quali non sono disponibili con una versione precedente, queste proprietà 

non sono a disposizione se si lavora con quest´ultima versione. Ciò può avere delle 

conseguenze indesiderate nel funzionamento runtime.  

Per creare nell´editor dei file runtime per versioni dal numero di serie inferiore, procedere come segue: 

1. selezionate il progetto nella struttura ad albero. 

2. passate alla proprietà di progetto, in particolare alla sezione Generale 

3. aprite la lista a cascata della proprietà Crea RT file per  

4. selezionate la versione desiderata: 

 Default: I file runtime vengono generati per la versione attuale dell´Editor. 

 6.20 SP4: i file runtime vengono generati per la versione 6.20 Servicepack 4. 

 6.21 SP0: i file runtime vengono generati per la versione 6.21 Servicepack 0. 

 6.21 SP1: i file runtime vengono generati per la versione 6.21 Servicepack 1. 

 6.22 SP0: i file runtime vengono generati per la versione 6.22 Servicepack 0. 

 6.22 SP1: i file runtime vengono generati per la versione 6.22 Servicepack 1.  

 6.50 SP0: i file runtime vengono generati per la versione 6.50 Servicepack 0. 

 6.51 SP0: i file runtime vengono generati per la versione 6.51 Servicepack 0. 

 7.00 SP0: i file runtime vengono generati per la versione 7.00 Servicepack 0. 

 Per garantire la consistenza dei file runtime, bisogna crearli di nuovo dopo ogni modifica di 

questa proprietà. Anche le configurazioni di tutti i driver vengono convertite. Le impostazioni che non 

esistono nella versione corrispondente, vengono settate su quelle di default.    

XML 

I dati esportati in formato XML sono a disposizione anche per l´import in versioni dell´editor con numero 

di serie più alto.  
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 se dei dati del RGM vengono salvati mediante la funzione di export nel runtime 

direttamente in formato XML, essi non possono essere importati di nuovo.  

 

5. Superficie 

L'interfaccia utente dell'editor si articola in diversi settori:  
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Elemento Contenuto 

01 - Barre simboli: Raccolta delle barre simboli (auf Seite 27) per l´editor e i suoi moduli. 

Sono a disposizione per: 

 Finestre ancorabili (auf Seite 31) 

 Orientamento (auf Seite 31) 

 Immagini (auf Seite 36) / Simboli (auf Seite 38) 

 Profili editor (auf Seite 40) 

 Elementi (auf Seite 42) 

 Barra menù (auf Seite 38) 

 Production & Facility Scheduler (auf Seite 44) 

 Trasporto remoto (auf Seite 46) 

 Generatore Report (auf Seite 48) 

 File runtime (auf Seite 50) 

 Livelli di visibilità (auf Seite 50) 

 Macro VBA (auf Seite 52) 

02 - Manager di progetto: Visuale ad albero del manager di progetto 

03 - Visualizzazione dettagliata del 

manager di progetto: 

Dettagli concernenti il modulo selezionato nel manager di progetto. 

04 - Finestra principale: Workspace principale; qui vengono visualizzati documenti come 

immagini o report. 

05 - Barra simboli Elementi: Barra simboli per gli elementi delle immagini - elementi vettoriali e 

dinamici 

06 - Proprietà Mostra le proprietà dell´oggetto selezionato. A questo scopo avete a 

disposizione tre modalità, che vengono selezionate nella Barra 

simboli delle porprietà (auf Seite 54). 

07 - Guida proprietà: Mostra delle brevi spiegazioni che concernono le proprietà di 

immagini, variabili, funzioni e altri elementi che vengono 

parametrizzati. 

08 - Finestra di emissione Visualizzatzione di segnalazioni se i progetti sono compilati e salvati 

nel runtime. 
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09 - Barra di stato: Mostra delle informazioni di stato per la disponibilità editor e per 

immagini. 

10 - Barra simboli Proprietà: Definisce visualizzazione e ordine delle proprietà; mostra la Guida 

proprietà (auf Seite 148).  

11 - Lista incrociata:  

Decidete quale finestra deve essere mostrata: 

  nella lista a cascata alla voce Opzioni  

L´ordine della finestra può essereadattata  (auf Seite 12) individualmente. La finestra principale è l´unica 

finestra che non può essere nascosta. 

 

5.1 Adatta visualizzazione 

Tutte le finestre dell´editor possono essere ordinate individualmente sullo schermo. Passate 

all´impostazione per ordinare le finestre cliccando con il tasto destro del mouse sul bordo della finestra. 

Le proprie impostazioni possono essere salvate nei Profili editor (auf Seite 79). 

MENU CONTESTUALE FINESTRA 

Opzioni Stato Funzione 

Dinamico attivo La finestra selezionata può essere posizionata liberamente sul dektop. 

Viene visualizzata nella finestra principale. Avete la possibilità di 

visualizzare più finestre in quella principale e passare dall´una all´altra. 

Cliccando due volte sul titolo si passa fra non ancorata e 

ancoraggio. 

 Inattiv

o 

(default) 

La finestra viene ancorata. La proprietà ancoraggio è attiva. 
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Agganciar

e 

attivo 

(default) 

Tenendo premuto il tasto sinistro del mouse premuto è possibile 

spostare  a piacere le singole finestre. Durante questo spostamento, un 

Aiuto di posizionamento (auf Seite 14) indica la posizione in cui è stata 

inserita la finestra. Al rilascio del tasto del mouse, la finestra viene 

ancorata e adattata alle altre adiacenti. 

Passando da non ancorata e ancoraggio, la finestra viene 

inserita in corrispondenza dell´ultima posione nella quale era ancorata. 

Cliccando due volte sul titolo si passa fra non ancorata e 

ancoraggio. 

 se volete spostare una finestra, ma non ancorarla, tenete 

premuto durante lo spostamento il tasto Ctrl. In questo caso non viene 

visualizzato nessun aiuto per facilitare il posizionamento. 

 Inattiv

o 

Tenendo premuto il tasto sinistro del mouse premuto è possibile 

spostare  a piacere le singole finestre. Quando lasciate il tasto, esse 

vengono visualizzate nel posto corrispondente in primo piano. 

La proprietà non ancorata è attiva. 

Inserisci 

nella 

finestra 

principal

e 

attivo La finestra viene visualizzata in quella principale come tab. 

Tutti i tab vengono visualizzati nella finestra principale. Cliccando sul 

titolo della finestra, passate da un tab all´altro. 

Per visualizzare un tab di nuovo in forma di finestra, aprite il menu 

contestuale cliccando con il tasto destro del mouse sul titolo della 

finestra e settate la proprietà  Apri nella finestra 

principale a non attiva. 

 Inattiv

o 

(default) 

La finestra viene visualizzata in modo normale. 

Nascondi 

automatic

amente 

attivo Non appena la finestra perde il focus del mouse, viene posta sullo sfondo. 

Il titolo della finestra viene visualizzato sul lato sinistro dell´editor. 

Per riportare la finestra in primo piano, spostate il mouse sul titolo della 

finestra. 

 Inattiv

o 

(default) 

La finestra viene visualizzata sempre in primo piano. 
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Esci  La finestra viene chiusa. 

Per renderla di nuovo visibile, selezionate nella Barra menu ->  Opzioni, la 

voce -> Nome finestra 

 

 

5.2 Posiziona finestre 

POSIZIONAMENTO 

Nell´editor di zenon tutte le finestre possono essere disposte a piacere sul desktop facendo uso di: 

 Drag & Drop: le finestre vengono trascinate nella posizione desiderata e vengono posizionate in 

modo libero (non ancorata), oppure ancorate. 

 Cliccando due volte sul titolo si passa fra non ancorata e ancoraggio. 

AIUTO PER IL POSIZIONAMENTO 

Quando si spostano delle finestre all´interno della superficie dell´editor, il sistema visualizza degli aiuti 

volti a facilitare il posizionamento. Questi ultimi rappresentano le finestre, o meglio i loro bordi.  

 

Questo elemento rappresenta un´area finestra nell´editor. 

 

Questo elemento rappresenta l´area al bordo dell´editor. 

POSIZIONA FINESTRE 

Per posizionare un elemento in modo ancorato: 

1. spostate l´elemento servendovi del mouse fino a raggiungere la posizione desiderata 



Superficie 

 

 

15 

 

 

2. comparirà sullo schermo l´aiuto di posizionamento 

3. esso rappresenta una finestra e i suoi settori 

a) Centro: finestra intera 

b) In sù: metà superiore 

c) In giù: metà inferiore 

d) Destra: metà di destra 

e) Sinistra: metà di sinistra 

o il bordo dell´editor 

4. spostate il mouse verso l´aiuto di posizionamento centrale o quello sul bordo dell´editor e, 

quando li avete raggiunti, portatevi nell´area desiderata  

5. l´area dell´editor sulla quale l´elemento è posizionato al momento del rilascio del tasto del 

mouse, viene colorata di blu 

6. spostate il mouse all´interno dell´aiuto di posizionamento finché l´area desiderata non si colora 

di blu 

7. rilasciate il tasto del mouse e l´elemento verrà posizionato 

8. Se una finestra viene posizionata su una finestra già esistente, entrambe verranno visualizzate 

nella stessa posizione usando tabs.  

1. La finestra Proprietà viene spostata ancorata. 
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2. Anche in questo caso compariranno gli aiuti di posizionamento. 

 

3. L´indicatore del mouse viene portato sulla freccia superiore dell´aiuto di posizionamento 

centrale. 
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4. Il settore di inserimento dell´editor diventa blu. 
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5. Quando si rilascia il tasto del mouse, la finestra viene inserita nella posizione evidenziata: 

 

6. adesso si deve portare il puntatore del mouse sul bordo superiore dell´aiuto di posizionamento. 
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7. Il settore di inserimento dell´editor diventa di nuovo blu. 
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8. Quando si rilascia il tasto del mouse, la finestra viene inserita nella posizione evidenziata: 

 
 

5.3 Modalità schermo intero 

Nell´editor di zenon potete visualizzare la finestra principale nella modalità a schermo intero. Per far ciò: 

 usate la combinazione di tasti Shift+F9  

oppure 

 selezionate nella lista a cascata Finestra, l´inserimento Modalità a schermo intero 

La modalità schermo intero esclude tutte le altre finestre e mostra solamente quella principale con tutti i 

documenti aperti (immagini, rapporti ....) in forma di immagine piena che occupa tutto lo schermo.  

La modalità schermo intero può essere terminata tramite: 

 il pulsante visualizzato per chiudere la modalità schermo intero  

 la combinazione tasti Shift +F9  

 il tasto Esc  
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LAVORARE NELLA MODALITÀ A SCHERMO INTERO 

Nella modalità a schermo intero viene visualizzato un menu che serve a terminare questa modalità di 

visualizzazione e ad aprire determinate finestre e barre simboli. 

 

Parametri Descrizione 

Chiudi schermo intero Chiude lo schermo intero. In alternativa, usate anche la 

combinazione di tasti Shift+F9, oppure il tasto Esc. 

Finestre ancorabili Lista a cascata che serve ad aprire le finestre: 

 Proprietà 

 Guida delle proprietà 

Le finestre vengono aperte la prima volta in una posizione 

determinata in modo fisso. Poi possono essere 

posizionate liberamente e vengono aperte in seguito 

nella modalità a schermo intero in corrispondenza della 

posizione definita individualmente. 

Toolbar Lista a cascata che serve ad aprire le barre simboli: 

 Immagini 

 Orientamento 

 Livello di visibilità 

 Elementi 

Le barre simboli vengono aperte la prima volta in una 

posizione determinata in modo fisso. Poi possono essere 

posizionate liberamente e vengono aperte in seguito 

nella modalità a schermo intero in corrispondenza della 

posizione definita individualmente. 
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5.4 Combinazioni di tasti 

GENERALE 

Comando Combinazione tasti  

Apri la guida F1 

Avvia / chiudi modalità schermo intero Shift+F9  

Remote: Chiudi modalità schermo intero Ctrl+Alt+Shift+F 

Avvia VSTA Editor  Alt+F10  

Avvia l'Editor VBA Alt+F11  

Wizard Apri selezione Alt+F12  

Apri explorer con particolare attenzione alla cartella 

SQ per il progetto attuale. 

Corrisponde a: %ProgramData%\COPA-

DATA\[SQL-Ordner]\[UID]\FILES 

Ctrl+Alt+E 

Apri explorer con particolare attenzione ai file del 

progetto attuale.  

Corrisponde a: %CD_USERDATA% 

Ad esempio: 

C:\Users\Public\Documents\<CD_zenon

_Projects 

Ctrl+Alt+D 

PROFILI EDITOR 

Comando  Combinazione tasti  

Carica profilo editor 1   Shift+F1  

Carica profilo editor 2  Shift+F2  

Carica profilo editor 3  Shift+F3  

Carica profilo editor 4  Shift+F4  

Carica profilo editor 5  Shift+F5  

Carica profilo editor 6  Shift+F6  
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Carica profilo editor 7  Shift+F7  

Carica profilo editor 8  Shift+F8  

  

Salva visuale editor attuale come:  

Profilo editor 1 Ctrl+Shift+F1  

Profilo editor 2  Ctrl+Shift+F2  

Profilo editor 3 Ctrl+Shift+F3  

Profilo editor 4  Ctrl+Shift+F4  

Profilo editor 5  Ctrl+Shift+F5  

Profilo editor 6  Ctrl+Shift+F6  

Profilo editor 7  Ctrl+Shift+F7  

Profilo editor 8  Ctrl+Shift+F8  

EDITOR GRAFICO  

il segno di più (+) significa che i tasti vanno premuti insieme.  

Ad esempio: 

 Ctrl+A significa: tenere premuto il tasto Ctrl e poi premere il tasto A. 

Ctrl++ significa tenere premuto il tasto Ctrl e premere il tasto +. 
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Comando  Combinazione tasti              

Finestra principale: scrollare contenuti con mano 

per trascinamento 

tenere premuto spazio 

Chiudi immagine attuale Ctrl+F4 

Apri proprietà Alt+Invio  

Comando  Combinazione tasti              

Seleziona più oggetti Tenere premuti Shift oppure 

Ctrl  

Deselezionare un elemento in caso di multiselect Ctrl+Clic del mouse 

Scegli: modifica successione. definisce l´elemento 

nei confronti del quale tutti gli altri si devono 

orientare. 

Tenere premuto Shift  al 

momento di effettuare la selezione. 

Seleziona oggetti nascosti 1. Premere Alt  

2. Cliccare sull´elemento e 

muoverlo.  

Seleziona tutti gli elementi di un´immagine. Ctrl+A  

Selezionare prossimo elemento nella successione 

della creazione. 

Tab 

Selezionare elemento precedente nella successione 

della creazione. 

Shift+Tab  

Comando  Combinazione tasti              

Spostare oggetto selezionato tasti freccia 

Spostare di 10 pixel per ogni pressione sul tasto con 

frecce 

Shift+Tasto con frecce  

Spostare solamente orizzontalmente oppure solo 

verticalmente 

Tenere premuto Shift  al 

momento di effettuare lo 
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spostamento.  

Centrare un oggetto selezionato nell´area di lavoro.  H  

Comando  Combinazione tasti              

Salva modifiche. Ctrl+S   

Inserisce elemento proveniente dagli appunti Ctrl+V  

Shift+Ins 

aggiunge elementi preso dagli appunti nella 

posizione originale. Originale e copia sono 

sovrapposti in modo perfetto. 

Ctrl+Shift+V  

Copia gli elementi selezionati Ctrl+C   

Ctrl+Ins 

Copia invece che spostare Tenere premuto Ctrlal momento 

di effettuare lo spostamento.   

Cancella un elemento selezionato Canc  

Taglia un elemento selezionato Shift + Del  

Ctrl+X  

Annulla modifiche Ctrl+Z  

Alt+Backspace 

Aggiungi o cancella nodo nell´elemento selezionato. 

Aggiungi: il cursore del mouse diventa un segno 

pulsante (+). 

Cancella: il cursore del mouse diventa un segno 

pulsante (-).  

 funziona con polilinee, poligoni o elementi 

condutture. 

Ctrl+Shift  

Termina disegno di polilinea e poligoni S  

Termina disegno di polilinea e poligoni e cancella 

l´ultima area parziale disegnata 

Esc 

Colloca elementi selezionati al livello superiore +   
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Colloca elementi selezionati al livello inferiore -   

Porta elementi selezionati in primo piano Ctrl++   

Porta elementi selezionati sullo sfondo Ctrl+- 

Comando  Combinazione tasti              

Modifica grandezza Posizionare il cursore del mouse sul 

punto di aggancio in modo tale che 

esso prenda la forma di una freccia. 

Poi, facendo uso dei tasti con 

le frecce si può procedere a 

stabilire la posizione con grande 

precisione tenendo premuto il tasto 

Shift in passi di 10 pixel. 

 se, facendo uso della 

proprietà Rotazione [°], si è definito 

un angolo non uguale a 0, non è 

possibile scalare usando i tasti con 

le frecce.  

Scalare oggetto in riferimento al punto centrale: Tenere premuto Altal momento di 

effettuare lo spostamento.   

Scalare in modo proporzionale: Tenere premuto Shift  al 

momento di scalare.  

Comando  Combinazione tasti  

Crea nuovo elemento per il modulo relativo Ins. 

Modifica la colonna selezionata  F2 

Copiare un elemento della lista selezionato Ctrl+C  

Inserisce un elemento copiato in precedenza Ctrl+V 

Cancellare un elemento della lista selezionato Del 

Scrollare diversi elementi nella lista verso l'alto Immagine su  

Scrollare diversi elementi nella lista verso il basso Immagine giù 
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Navigare nella lista Tasti con frecce 

RUNTIME 

Comando  Combinazione tasti  

Avvia il Runtime; vengono creati i file Runtime 

modificati in precedenza.  

F5 

Crea i file runtime modificati F7 

Sfoglia attraverso la finestra windows aperta Alt+Tab 

Terminare il runtime Alt+F4  

Aprire explorer con focus su cartella per i file 

runtime.  Il progetto deve essere prima selezionato 

nella struttura ad albero.  

Ctrl+Alt+D  

Aprire explorer con focus su cartella con il progetto 

runtime.  Il progetto deve essere prima selezionato 

nella struttura ad albero.  

Ctrl+Alt+R 

 
 

6. Toolbar 

Le barre simboli principali vengono posizionate nell´editor di defaullt sotto la Barra menu. Fatta 

eccezione per la barra simboli Elementi; essa, infatti, viene visualizzata a destra accanto alla Finestra 

principale. Se si muove il mouse su un simbolo, viene visualizzata nella barra di stato un´informazione 

concernente la funzione del simbolo.  

Le seguenti barre simboli principali sono disponibili: 

 Finestre ancorabili (auf Seite 31) 

 Orientamento (auf Seite 31) 

 Immagini (auf Seite 36) / Simboli (auf Seite 38) 

 Profili editor (auf Seite 40) 

 Elementi (auf Seite 42) 

 Barra menù (auf Seite 38) 



Toolbar 

 

 

28 

 

 

 Production & Facility Scheduler (auf Seite 44) 

 Trasporto remoto (auf Seite 46) 

 Generatore Report (auf Seite 48) 

 File runtime (auf Seite 50) 

 Livelli di visibilità (auf Seite 50) 

 Macro VBA (auf Seite 52) 

Le seguenti finestre dispongono di una barra simboli propria, che viene visualizzata sul margine 

superiore della finestra stessa: 

 Dettagli workspace (auf Seite 54) 

 Proprietà (auf Seite 54) 

  Informazioni 

I titoli delle barra simboli corrispondono sempre alla lingua attiva nell´editor al momento 

in cui le barre stesse sono state aperte per la prima volta. Nel caso in cui, per esempio, la 

barra simboli 'Immagini' sia stata usata per la prima volta in tedesco, conserva il suo 

nome anche se in seguito nell´editor si passa all´inglese.  

Se volete cambiare la lingua dei nomi, dovete anzitutto cancellare tutti i profili editor, 

avviare l´editor nella lingua desiderata e poi attivare le barre dei simboli. 

Non cancellate i profili editor in zenon, ma a livello dei file di sistema. (Dettagli su questo 

tema li trovate nel capitolo  Cancella profili editor (auf Seite 88).) 

AZIONI CON SIMBOLI E BARRE SIMBOLI 

Le opzioni per le barre simboli vengono impostate alla voce: Opzioni- > Impostazioni -> Tab Barra 

simboli (auf Seite 79) 

Azioni per barre simboli:  

 posiziona liberamente sullo schermo  

 Chiudi 

 Apri 

Azioni per simboli:  
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 Elimina 

 Aggiungi 

POSIZIONA BARRA SIMBOLI 

1. Clliccate con il tasto sinistro del mouse in un settore libero della barra simboli. 

2. Trascinate la barra simboli nella posizione desiderata dello schermo. 

3. Un rettangolo sta ad indicare il posto nel quale la barra simboli verrà inserita. 

4. Rilasciate il tasto del mouse per posizionare la barra simboli. 

barre simboli, che contengono liste a cascata, possono essere posizionate solo orizzontalmente.   

CHIUDI BARRA SIMBOLI 

Potete chiudere delle barre simboli o tramite la lista a cascata Opzioni, oppure con la  Impostazioni 

sotto opzioni. 

1. Cliccate sulla lista a cascata Filtro 

2. navigare per raggiungere la barra simboli 

3. cliccate sull´inserimento relativo alla barra simboli da chiudere  

1. aprite il menu  Opzioni -> Impostazioni -> Tab: Barra simboli (auf Seite 79)  

2. Eliminate il segno di spuntatura accanto alla barra simboli desiderata.  

3. confermate la selezione cliccando su OK  
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APRI BARRA SIMBOLI 

Potete aprire delle barre simboli o tramite la lista a cascata Opzioni, oppure con la  Impostazioni 

sotto opzioni. 

1. Cliccate sulla lista a cascata Filtro 

2. navigare per raggiungere la barra simboli 

3. cliccate sull´inserimento relativo alla barra simboli da aprire  

1. aprite il menu  Opzioni -> Impostazioni -> Tab: Barra simboli (auf Seite 79)  

2. settate il segno di spuntatura accanto alla barra simboli desiderata.  

3. confermate la selezione cliccando su OK  

AGGIUNGI SIMBOLO 

1. aprite il menu  Opzioni -> Impostazioni -> Tab: Comandi (auf Seite 77) 

2. Selezionate nella finestra a sinistra una categoria. 

3. Cliccate nella finestra di destra con il tasto sinistro del mouse sul simbolo desiderato. 

4. tenendo premuto il tasto sinistro del mouse, trascinate il simbolo nella posizione desiderata 

nella barra dei simboli 

CANCELLA SIMBOLI 

1. aprite il menu  Opzioni -> Impostazioni -> Tab: Barra simboli (auf Seite 79) 

2. vengono attivati tutti i simboli di tutte le barre nell´editor  

3. Cliccate con il tasto sinistro del mouse sul simbolo.  

4. Trascinate il simbolo fuori dalla barra simboli e rilasciate il tasto del mouse. 
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6.1 Barra simboli Finestra docking 

Le seguenti finestre nascoste oppure chiuse possono essere riattivate sempre con la barra simboli per  

Finestre docking.  

 

Simbolo 

(da sinistra a destra) 

Funzione 

Manager di progetto  Attiva il Manager di progetto. 

Finestra di emissione Attiva la finestra di emissione. 

Lista incrociata  Attiva la lista riferimenti incrociati. 

Finestra di proprietà Attiva la finestra di proprietà. . 

Guida delle proprietà Attiva la finestra della guida delle proprietà. . 

Opzioni barra 

strumenti  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso 

del menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli 

strumenti può essere chiusa cliccando sul pulsante X. 

 

 

6.2 Barra simboli Orientamento 
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Nu
m. 

Simbolo Funzione 

01 orienta a sinistra Orienta tutti gli elementi selezionati al margine sinistro 

dell´elemento che è stato selezionato per primo. 

02 orienta a destra Orienta tutti gli elementi selezionati al margine destro 

dell´elemento che è stato selezionato per primo. 

03 orienta verso l´alto Orienta tutti gli elementi selezionati al margine superiore 

dell´elemento che è stato selezionato per primo. 

04 orienta verso il basso Orienta tutti gli elementi selezionati al margine inferiore 

dell´elemento che è stato selezionato per primo. 

05 Centra orizzontalmente Orienta l´elemento selezionato al centro orizzontale 

dell´immagine.  

Nel caso in cui siano stati selezionati più elementi, si orientano 

tutti all´elemento che è stato selezionato per primo. 

06 Centra verticalmente Orienta l´elemento selezionato al centro verticale dell´immagine.  

Nel caso in cui siano stati selezionati più elementi, si orientano 

tutti all´elemento che è stato selezionato per primo. 

07 Stessa distanza X Allinea gli elementi selezionati nella successione della loro 

selezione lungo l´asse x; i primi due elementi stabiliscono la 

distanza. 

08 Stessa distanza Y Allinea gli elementi selezionati nella successione della loro 

selezione lungo l´asse y; i primi due elementi stabiliscono la 

distanza. 

09 Stessa distribuzione X: Distribuisce tutti gli elementi selezionati lungo l´asse x fra i due 

elementi che sono stati selezionati per primi. Per questa opzione 

devono essere selezionati almeno tre elementi. 

10 Stessa distribuzione Y: Distribuisce tutti gli elementi selezionati lungo l´asse y fra i due 

elementi che sono stati selezionati per primi. Per questa opzione 

devono essere selezionati almeno tre elementi. 

11 Stessa larghezza  Gli elementi selezionati vengono adattati alla larghezza del primo 

elemento selezionato. 

Nota: Un adattamento si verifica sulla base delle coordinate 

ottiche. Per i dettagli a questo proposito, vedi la spiegazione sotto 

questa tabella. 

12 Stessa altezza  Gli elementi selezionati vengono adattati all´altezza del primo 
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elemento selezionato.  

Nota: Un adattamento si verifica sulla base delle coordinate 

ottiche. Per i dettagli a questo proposito, vedi la spiegazione sotto 

questa tabella. 

13 Stesse dimensioni Gli elementi selezionati vengono adattati all´altezza  e alla 

larghezza del primo elemento selezionato. 

Nota: Un adattamento si verifica sulla base delle coordinate 

ottiche. Per i dettagli a questo proposito, vedi la spiegazione sotto 

questa tabella. 

14 Porta in primo piano  Porta gli elementi selezionati in primo piano.  

15 Sposta avanti  Porta gli elmenti selezionati avanti di un livello.  

16 Sposta indietro Porta gli elmenti selezionati indietro di un livello. 

17 Porta sullo sfondo Porta gli elementi selezionati sullo sfondo.  

18 Rifletti orizz.  Rispecchia l´elemento selezionato su un´asse orizzontale.  

19 Rifletti vertic.  Rispecchia l´elemento selezionato su un´asse verticale.  

20 gira di 90°  Gira l´elemento selezionato di 90° in senso antiorario.  

21 Crea simbolo  Crea un nuovo simbolo da tutti gli elementi selezionati.  

22 Dividi simbolo  Il simbolo viene diviso nei suoi elementi originari; il simbolo non 

esiste più.  

23 Modalità di modifica singola 

simbolo / elemento 

Consente di modificare i singoli elementi di un simbolo. Il pulsante 

fa passare tra modalità di editazione oggetti singola e modalità 

editazione simbolo 

24 Aggiungi in simbolo esistente  Apre la barra dei simboli per aggiungere il simbolo attivo in un 

simbolo della lista.  

25 Elimina da un simbolo. Elimina l´elemento selezionato dal simbolo attivo. Poi l´elemento 

non appartiene più al simbolo.  

26 Sostituisci collegamenti Apre il dialogo per sostituire delle variabili o funzioni 

collegate con elementi dinamici.  Dettagli:  vedi capitolo 

Sostituzione di variabili di processo in elementi 

dinamici.Variabili di processo in elementi dinamici.  

Variabili di processo in elementi dinamici.  

Variabili di processo in elementi dinamici.  
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Variabili di processo in elementi dinamici.  

Variabili di processo in elementi dinamici.  

 

27 Trasmetti proprietà Trasmette le proprietà di un elemento selezionato ad un 

altro o a più altri.  

 Trasmettere ad un elemento: 

cliccare su un elemento con proprietà originarie  ->  

cliccare sul simbolo Trasmetti proprietà ->  cliccare 

sull´elemento di destinazione: Le proprietà vengono 

trasmesse.  

 Trasmettere a più elementi: 

selezionare elemento fonte  -> selezionare gli 

elementi di destinazione tenendo premuto il tasto 

Ctrl (sia l´elemento fonte che quelli di destinazione 

sono evidenziati; quello fonte è caratterizzato anche 

dalla presenza di punti di appiglio neri) -> cliccare 

sul simboloTrasmetti proprietà. Le proprietà 

dell´elemento fonte vengono trasmesse agli 

elementi di destinazione.  

Quali proprietà vengono trasmesse, dipende dall´oggetto fonte e 

da quello di destinazione. Di norma, vengono trasmessi colori, 

caratteri, allineamento paragrafo e bordi.  

Se sono stati selezionati più elementi come fonte, verranno 

trasmesse le proprietà del primo elemento selezionato. 

28 Opzioni barra 

strumenti  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo 

uso del menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente 

(sganciata dall´Editor), le opzioni non vengono visualizzate. .  La 

barra degli strumenti può essere chiusa cliccando sul pulsante X. 

ADATTAMENTO STESSA LARGHEZZA/ALTEZZA/DIMENSIONE 
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L´adattamento della dimensione di elementii ruotati e non ruotati fa riferimento alle coordinate ottiche, 

non a quelle logiche.   L´estensione di elementi ruotati viene intesa come superficie del rettangolo, 

all´interno delle cui linee immaginarie si trova l´elemento ruotato (Bounding Rectangle).    

Due elementi prima dell´adattamento:  

 

Dopo l´adattamento tramite Stessa altezza: 
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6.3 Barra simboli Immagini 

Per la modifica delle immagini avete a disposizione una barra dei simboli apposita. Essa viene 

visualizzata di dafault sotto la barra di menu. 
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Simbolo 

(da sinistra a destra) 

Funzione 

Salva immagine Salva l'immagine attiva.  

Salva tutto Salva tutte le immagini modificate. 

Taglia  Taglia l'elemento attivo e lo salva negli appunti, anche per più progetti. 

Disponibile solo se è stato selezionato un elemento. 

Copiare Salva una copia dell´immagine attuale negli appunti. Disponibile solo se è 

stato selezionato un elemento. 

Inserisci Aggiunge un´immmagine presa dagli appunti. Disponibile solamente se gli 

appunti contengono dei dati. 

Ridisegna 

immagine  

Attualizza la visualizzazione dello schermo. 

Modifica  Passa dallo zoom alla  modalità modifica. 

Annulla Permette di annullare fino a 100 azioni. Di default possono essere annullate 

fino a 10 azioni.  

Definisci il numero delle azioni: Opzioni -> Impostazioni -> Impostazioni -> 

Numero delle azioni annullate. Indicate un numero fra 1 e100. 

Zoom  Mette a disposizione due modalità di zoom: 

 Zoom senza livelli:  

Si può inserire nel Combobox un valore qualsiasi compreso fra 15% e  400%, 

oppure si può scegliere un valore preimpostato.  

 Zoomtool:  

facendo uso dei simboli della lente di ingrandimento (+ e -) è possibile zoomare 

direttamente nell´immagine servendosi del mouse. Premete il tasto Ctrl  e 

passate da una modalità all´altra. Il livello di zoom definito viene salvato per ogni 

singola immagine. 

Chiudi modalità zoom: cliccate sul simbolo Modifica. nella barra dei simboli 

Elementi. 

Stampa L'intero contenuto dello schermo viene stampato mediante la 

stampante che è stata selezionata come standard. Proprietà di stampa 

sotto File -> Configurazione generale -> Standard. 

Guida Apre la guida in linea. 
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Opzioni barra 

strumenti  
Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso del 

menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli 

strumenti può essere chiusa cliccando sul pulsante X. 

 

 

6.4 Barra simboli Simboli 

La libreria dei simboli vene gestita facendo uso del menu contestuale oppure della barra simboli: 

 

Barra 
simboli 

Menu Funzione 

1 Nuovo simbolo Viene impostato un nuovo simbolo. 

3 Apri simbolo Apre il simbolo nell´editor dei simboli per effettuare delle 

modifiche. 

2 Nuovo gruppo... Viene creato un nuovo gruppo simboli che può essere riempito di 

simboli selezionati della libreria, oppure con simboli crati ad hoc. 

(Copiare ed inserire) Disponibile solo nella biblioteca di simboli 

globale. 

4 Inserisci simbolo 

nell´immagine in 

modalità scollegata. 

Inserisce il simbolo nell´immagine in modalità scollegata.(per i 

dettagli vedi il sottocapitolo Simboli separati ). 

5 Inserisci simbolo 

nell´immagine in 

modalità collegata. 

Inserisci simbolo nell´immagine in modalità collegata. (per i 

dettagli vedi il sottocapitoloSimboli collegati).  
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13 Visualizzazione 

piatta 
Ordina tutti i imboli in una lista piatta. Semplifica la ricerca di un 

determinato simbolo. 

 in questo tipo di visualizzazione non possono essere né 

creati, né eliminati dei simboli; non è possibile neppure copiare 

oppure aggiungere simboli provenienti dagli appunti. 

14 Visualizzazione 

gerarchica 
Ordina tutti i simboli in modo gerarchico in sottogruppi e mostra 

le relazioni di dipendenza.  

6 Copiare Copia il simbolo selezionato negli appunti (solo nella 

visualizzazione gerarchica). 

7 Inserisci Incolla il simbolo copiato nel gruppo attivo (solo nella 

visualizzazione gerarchica). 

8 Elimina Cancella il simbolo selezionato, oppure il gruppo di simboli (solo 

nella visualizzazione gerarchica).  

 non si può annullare la cancellazione! 

9 Modifica celle 

selezionate 
Permette la modifica dei contenuti della cella selezionata.   

10 Sostituisci testo 

nella cella 

selezionata... 

Apre il dialogo che serve alla sostituzione automatica di testi 

(disponibile solamente se sono selezionate delle celle che 

possono contenetere del testo). 

11 Proprietà Apre la finestra Proprietà per il simbolo selezionato. 

12 Espandi/riduci nodi Nella visualizzazione gerarchica, permette di ingradire o ridurre il 

nodo selezionato o tutti i nodi.  

15 Esporta selezione in 

XML 
Apre il dialogo per l´export in formato XML dei simboli 

selezionati. (Per i dettagli vedi capitolo Import / Export Simboli 

16 Importa XML Importa simboli da un file XML  (vedi capitolo  Import/Export 

Simboli). 

18 Rimuovi tutti i 

filtri 
Elimina tutti i filtri settati nel titolo della colonna. 

19 Guida Apre la giuda in linea relativa al menu contestuale. 

17 - Torna indietro all´elemento di partenza (solo barra simboli). 

 Opzioni barra 

strumenti  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva 

facendo uso del menu Opzioni -> Barre dei simboli.  
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Nota: per una barra degli strumenti posizionata liberamente 

(sganciata dall´Editor), le opzioni non vengono visualizzate. .  La 

barra degli strumenti può essere chiusa cliccando sul pulsante X. 

 

 

6.5 Barra dei simboli Profili editor 

I profili editor possono essere gestiti comodamente facendo uso della barra dei simboli corrispondente.  
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Simbolo  

(da sinistra a destra) 

Funzione 

Carica profilo editor 

selezionato 
Carica il profilo selezionato nel settore Seleziona profilo editor. 

Seleziona profilo 

editor 
Lista a cascata (auf Seite 88) con 10 profili. 

Carica profilo 

standard 
Resetta tutte le impostazioni relative a visualizzazione e posizione delle 

finestre, nonché contenuti e visualizzazione delle barre dei simboli e dello 

stato di emissione; poi carica il profilo standard di zenon. 

Carica Profili 

predefiniti: (auf Seite 

80) 

carica i profili predefiniti di COPA-DATA sui primi tre posti di memoria e li 

collega ai moduli.  Profili eventualmente già esistenti vengono sovrascritti.  

Elimina attribuzioni 

di profili: (auf Seite 80) 
Cancella tutti i collegamenti di profili predefiniti con i moduli.  

Salvataggio automatico 

dei profili editor  
Attivo: le modifiche del profilo attuale vengono salvate 

automaticamente al momento dell´apertura di un altro profilo.   

Disattivato: le modifiche non vengono salvate al momento del 

cambiamento di profilo; quando si richiama un´altra volta il profilo in 

questione, vengono riproposte le posizioni originali.   

Salva profilo editor 

selezionato 
Salva le impostazioni finestra attuali nel profilo che è visualizzato nel settore 

Seleziona profilo editor. 

Assegna nomi 

individuali ai profili 

editor.  

Apre un Dialogo (auf Seite 88) in cui possono essere assegnati dei nomi 

individuali ai profili editor.   

Opzioni per barre 

dei simboli  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso del 

menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli strumenti 

può essere chiusa cliccando sul pulsante X. 
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6.6 Barra dei simboli Elementi 
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Nu
m. 

Simbolo Funzione 

01 Rettangolo Con colore e tipo di linea e di riempimento;  

02 Linea larghezza, colore e tipo di linea definibile  

03 Rettangolo 

arrotondato 

Rettangolo con angoli arrotondati definibili liberamente.  

04 Ellisse/Cerchio Con colore e tipo di linea e riempimento  

05 Poligono Con colore e tipo di linea e di riempimento; 

06 Polilinea Con tipo e colore della linea (se descrive un’ area piana chiusa, anche tipo 

e colore di riempimento)  

07 Curva larghezza, colore e tipo di linea definibile  

08 Arco di cerchio disegna un segmento di cerchio con un angolo di apertura di 180° 

(modificabile), spessore, colore e tipo della linea definibili.  

10 Testo statico Con colore e selezione del tipo di carattere 

09 Tubatura  Con colore e tipo di linea e di riempimento;  

11 Bargraf Rappresentazione dei valori su un bargraf  

12 Valore numerico Visualizzazione dei valori in forma numerica  

13 Collega testo Visualizza testi associati a valori limite 

14 Elemento Trend Visualizzazione semplice con grafica lineare  

15 Strumento 

analogico 

Visualizzazione valori in forma analogica 

16 Elemento di 

stato 

Riprendere i colori dalla progettazione dello stato delle variabili  

17 Pulsante zona di comando in rappresentazione di buttone  

18 Interruttore Semplice comando per l’ impostazione di valori limite  

19 Multibin Rappresentazione di più variabili di processo su un punto ad immagine con 

colori e simboli  

20 Pulsante allarme 

ad immagine 

Disponibile solo con licenza per SICAM 230 

21 Elemento di Visualizzazione di testi da una tabella testi  
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segnalazione 

22 Orologio Data ed ora  

23 Elemento di 

comando 

Disponibile solo con licenza per SICAM 230 

24 Elemento 

combinato 

Visualizza una o più variabili su un unico punto d’ immagine con colori e 

simboli (sequenza caratteri) 

25 Allarme ad 

immagine 

Disponibile solo con licenza per SICAM 230 

26 ActiveX Element Inserire elementi AktivX 

27 Slider 

universale 

Slider/potenziometro  

28 Combo/ListBox Collega i valori di variabili con messaggi di testo.  

29 Elemento WPF Rappresenta file WPF-XAML validi. 

30 Modifica Cambia da zoom a modalità di modifica 

 Opzioni barra 

strumenti  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso del 

menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli strumenti 

può essere chiusa cliccando sul pulsante X.  

 
 

6.7 Barra dei simboli del Production and Facility Scheduler 

Il modulo Production Facility Scheduler può essere modificato anche mediante una barra di simboli. 
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Simbolo 

(da sinistra a destra) 

Funzione 

Rinomina Permette il cambiamento della denominazione di un impianto. 

Proprietà Apre una finestra con le proprietà dell´impianto. 

Elimina Elimina l´impianto selezionato dopo una conferma. 

Ordinamento crescente Ordina la tabella/colonna selezionata in direzione crescente. 

Ordinamento 

decrescente 

Ordina la tabella/colonna selezionata in direzione decrescente. 

Cambia data Apre il dialogo che serve ad inserire una data e cambia portandosi a 

questa data. 

Mostra oggi Passa dalla data indicata alla data attuale. 

Visualizzazione 

giorno 

Mostra un giorno nel calendario. 

Vista settimanale Mostra una settimana nel calendario. 

Visualizzazione 

mensile 

Mostra un mese nel calendario. 

Elemento precedente. Torna indietro nel calendario di un elemento in corrispondenza della 

visualizzazione impostata (il che significa di un giorno, di una settimana 

o di un mese). 

Prossimo elemento Va avanti nel calendario di un elemento in corrispondenza della 

visualizzazione impostata (il che significa di un giorno, di una settimana 

o di un mese). 

Anteprima punti di 

commutazione 

Apre l´anteprima dei punti di commutazione. 

Opzioni barra 

strumenti  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso 

del menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli 

strumenti può essere chiusa cliccando sul pulsante X. 

 

 



Toolbar 

 

 

46 

 

 

6.8 Barra simboli Trasporto remoto 

Un computer di sviluppo può realizzare delle connessioni remote con altri calcolatori. La batta simboli 

Trasporto remoto mette a disposizione delle funzioni che servono alla trasmissione e alla 

interrogazione di dati. 
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Simbolo  

(da sinistra a destra) 

Funzione 

Trasporto Remoto: 

Stabilisci 

collegamento  

Instaura un collegamento con il computer destinatario.  

Trasporto Remoto: 

Impostazioni di 

collegamento 

Apre il dialogo per la configurazione del collegamento. 

Remote: Trasporta 

file Runtime 

modificati  

Trasmette al computer di destinazione tutti i file runtime modificati sul 

computer di sviluppo.  

Remote: Importa tutti 

file Runtime  

Rilegge tutti i file modificabili nel runtime (come ricette, oppure 

gestione user) sul computer di sviluppo.  

Remote: Imposta 

progetto di partenza 

Setta il progetto di partenza per il computer di destinazione.  

Remote: Avvia Runtime  Avvia il runtime sul computer di destinazione.  

Remote: Termina 

Runtime 

Chiude il runtime sul computer di destinazione. 

Remote: Aggiorna 

progetto  

Esegue sul computer di destinazione la funzione aggiorna. 

Remote: Avvia 

connessione con il 

desktop 

Avvia un collegamento che serve a consentire la gestione del computer 

di destinazione via Remote Desktop. 

Opzioni barra 

strumenti  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso 

del menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli 

strumenti può essere chiusa cliccando sul pulsante X. 

Ulteriori simboli possono essere 

aggiunti facendo uso di Opzioni 

della barra simboli (auf Seite 77): 

 

Trasporta tutti i Trasmette tutti i file Runtime al sistema di destinazione. 
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file Runtime 

Riavvia il sistema 

operativo remoto 

Riavvia il sistema operativo del computer di destinazione dopo aver 

effettuato un controllo di sicurezza. Questa opzione non viene 

supportata con Windows CE. 

Rileva lo stato di 

sistema remoto 

Rileva lo stato del sistema del computer di destinazione e scrive i dati 

nella finestra di emissione.  Il sistema rileva quanto segue: 

 Nome Computer 

 Sistema operativo 

 Runtime attivo/non attivo 

 Progetto di partenza 

 Memoria reale 

 Processori  

 Numero di serie remoto 

 Numero di attivazione remoto  

 la versione remota di zenon 

Cambia la password e 

visualizza la licenza 

Apre Dialogo per connessione. 

Consente: 

 Modifica della password per la connessione  

 Visualizzazione e modifica della licenza del calcolatore di destinazione 

 Configurazione della Crittografia sul calcolatore di destinazione  

  

 tutti i comandi per il trasporto remoto sono a disposizione anche nel Menu contestuale del 

progetto. 

 

6.9 Barra simboli del Generatore di rapporti 

Per il generatore di rapporti avete a disposizione una barra di simboli nell´editor: nel caso in cui non 

dovesse essere visibile, la si può visualizzare mediante: 

1. aprite il menu  Opzioni -> Impostazioni -> Tab: Barra simboli (auf Seite 79) 
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2. attivate il checkbox accanto al Generatore di rapporti 

3. confermate la selezione cliccando su OK 

 

Simbolo 

(da sinistra a destra) 

Funzione 

Stampa report Stampa il rapporto con la stampante impostata come standard. 

Anteprima pagina 

report 

Apre il rapporto in un´anteprima. Il rapporto può essere ingrandito oppure 

rimpicciolito (zoom); lo si può sfogliare e stampare. 

Ridisegna report Attualizza la visualizzazione. 

Ricalcola funzioni Calcola nuovamente le formule nel report 

Assistente alle 

funzioni 

Apre un dialogo che serve di aiuto per la configurazione delle funzioni. 

Carattere Apre un dialogo che serve alla formattazione delle celle con attenzione 

particolare al tab Carattere. 

orientamento testo Apre un dialogo che serve alla formattazione delle celle con attenzione 

particolare al tab Orientamento. 

Cornice Apre un dialogo che serve alla formattazione delle celle con attenzione 

particolare al tab Cornice. 

Disegno Apre un dialogo che serve alla formattazione delle celle con attenzione 

particolare al tab Disegno. 

Opzioni barra 

strumenti  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso del 

menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli strumenti 

può essere chiusa cliccando sul pulsante X. 
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6.10 Barra simboli File runtime 

Per trasferire dei file dall´editor al runtime, oppure viceversa, avete a disposizione una barra di simboli:  

 

Simbolo 

(da sinistra a destra) 

Funzione 

Crea i file runtime 

modificati 

Crea file runtime di tutti i file modificati nell´editor.  Scegliete nel menu 

dropdown se i file runtime devono essere generati solo per il progetto 

attivo, o per tutti i progetti caricati.  

Crea tutti i file 

runtime 

Crea file runtime per tutti i file esistenti nell´editor.  Scegliete nel menu 

dropdown se i file runtime devono essere generati solo per il progetto 

attivo, o per tutti i progetti caricati.  

Importa i file 

runtime 

I file modificabili nel runtime (come ricette oppure gestione utenti) 

vengono riletti dal runtime nell´editor.   

Runtime: file 

modificabili 

Apre il Dialogo che serve alla gestione dei file modificabili durante il 

Runtime.   

Lanciare runtime Avvia il runtime.   

Opzioni per barre 

dei simboli 

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso 

del menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli 

strumenti può essere chiusa cliccando sul pulsante X. 

 

 

6.11 Barra simboli Livelli di visibilità 

In modo simile a quanto accade nei programmi CAD, si possono definire nell´editor dei livelli di visibilità, 

che possono essere assegnati poi a singoli elementi.  In tal modo è possibile nascondere nel caso di 

immagini complesse quegli elementi che non sono necessari, che poi, però, possono essere resi di nuovo 

visibili in qualsiasi momento.  Sono a disposizione ben 15 livelli di visibilità.  L´attribuzione di un livello 
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viene effettutata nella proprietà Livello di visibilità nel nodoGenerale. L´attivazione o la disattivazione 

dei singoli livelli avviene facendo uso dei pulsanti della barra simboli Livelli di visibilità: 

 

Simbolo 

(da sinistra a destra) 

Funzione 

Mostra tutti i livelli di 

visibilità 

Visualizza tutti i livelli.  

Nascondi tutti i livelli 

di visibilità 

Nasconde tutti i livelli.  

Livello di visibilità<Nr> Mostra o nasconde il livello di visibilità corrispondente.  

Opzioni per barre dei 

simboli  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva 

facendo uso del menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente 

(sganciata dall´Editor), le opzioni non vengono visualizzate. .  

La barra degli strumenti può essere chiusa cliccando sul 

pulsante X.  

 

  Informazioni 

I livelli di visibilità valgono solamente per l´Editor e non hanno alcun influsso sul Runtime.    

 gli elementi di controllo vengono visualizzati nel 

Runtime sempre al primo posto.   Ciò vale anche quando essi vengono coperti da altri 

elementi nell´Editor.  In tal modo si vuole garantire che essi siano sempre raggiungibili.   
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6.12 Barra degli strumenti "Lista macro" 

Le macro che sono state realizzate usando VBA, possono essere gestite tramite la barra simboli VBA. 
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Simbolo  

(da sinistra a destra) 

Funzione 

Ricarica la lista delle macro 

VBA./VSTA 
Carica tutte le macroPublic Sub Name ()  contenute in 

myWorkspace e nei moduli nella lista dropdown della barra 

simboli. 

Cerca macro Cerca macro tramite il campo di inserimento della combobox, 

oppure selezione dalla lista a cascata.  La lista a cascata viene 

adattata all´elemento più ampio quando viene aperta.   

Macro della lista a cascata  Contiene tutte le macro caricate e ne permette la selezione.  

Esegui le macro selezionate.  Esegue la macro selezionata nella lista a cascata (dropdown).  

Esegui la macro #<x> 

assegnata.  
Esegue la macro assegnata al simbolo. 

Assegna macro  Apre il dialogo che serve all´assegnazione di macro. Con i simboli 

possono essere collegate da 1 a 5 macro. 

VBA Filtra alla ricerca di macro VBA. Vengono visualizzate solamente 

macro VBA. 

VSTA Filtra alla ricerca di macro VSTA. Vengono visualizzate solamente 

macro VSTA. 

ALL Cancella il filtro attualmente in uso e vengono visualizzate tutte le 

macro.   

AZ Mette le macro in ordine ascendente, da 0 a 9 e dalla A alla Z.   

ZA Mette le macro in ordine discendente, dalla Z alla A e da 9 a 0.  

Opzioni barra strumenti  Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo 

uso del menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente 

(sganciata dall´Editor), le opzioni non vengono visualizzate. .  La barra 

degli strumenti può essere chiusa cliccando sul pulsante X. 

  Informazioni 
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Simbolo  

(da sinistra a destra) 

Funzione 

Nel caso in cui nel dialogo di attribuzione non vengano offerte tutte la macro 

contenute in myWorkspace, eseguite nella barra dei simboli la funzioneRicarica la 

lista delle macro VBA.  

 

 

6.13 Barra dei simboli della sezione lista 

Nella visualizzazione dettagliata del Manager di progetto vengono visualizzate le barre dei simboli 

relative al tipo di nodo attivato. Queste ultime corrispondono al contenuto del menu contestuale 

corrispondente.  La guida relativa alle singole barre dei simboli la trovate nel capitolo corrispondente, 

per esempio:  Variabili Visualizzazione dettagliata Barra simboli  

 

6.14 Barra dei simboli Proprietà 

Le proprietà di un oggetto vengono visualizzate e modificate nella finestra delle proprietà. Per 

organizzare la finestra delle porprietà è a Vostra disposizione una barra di simboli: 
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Simbolo 

(da sinistra a destra) 

Funzione 

Visualizzazione a 

gruppi (auf Seite 

144)  

(default) 

Tutte le proprietà dell´oggetto selezionato vengono raggruppate secondo 

un criterio logico e i gruppi vengono ordinati o in ordine alfabetico 

oppure in modo logico. Attraverso il menu contestuale possono essere 

aggiunti o eliminati inserimenti dai Favoriti.  

 Le indicazioni del manuale sulle proprietà 

partono sempre dalla visualizzazione a gruppi.. I contenuti dei gruppi 

corrispondono quelli della Visuale a dialogo. 

Tutte le 

proprietà (auf 

Seite 146)  

Tutte le proprietà dell'oggetto selezionato vengono rappresentate in una 

lista. Attraverso il menu contestuale possono essere aggiunti o eliminati 

inserimenti dai Favoriti.  

Vista a dialogo 

(auf Seite 145)  

Tutte le proprietà vengono riassunte in modo logico come nei Gruppi 

di rappresentazione e i gruppi sono ordinati secondo la 

frequenza e la priorità del loro uso. In questa visualizzazione non possono 

essere definiti dei favoriti. 

Mostra/nascondi i 

favoriti (auf Seite 146) 

Mostra o nascondo nelle visuali  Gruppi di rappresentazione 

oppure  Tutte le proprietà il nodo Favoriti.  In esso sono 

raccolte quelle proprietà che vengono utilizzate più frequentemente.  

Di default vengono proposti dei favoriti.  

Aggiungi o cancella dai favoriti degli inserimenti:  Ciò accade mediante il 

menu contestuale 'Aggiungi ai favoriti', o mediante Drag&Drop 

delle proprietà nella lista dei favoriti.  

La successione delle proprietà nei favoriti viene definita dal criterio di 

classificazione prescelto (ordine crescente, decrescente, logico).  

NellaVisuale di dialogo non possono essere creati dei favoriti.  

Mostra/nascondi 

tutte le 

proprietà 

Mostra o nasconde tutti i nodi nelle visuali Raggruppato e Tutte le 
proprietà 

Ordinamento 

logico  

(default) 

Mostra nelle visuali Raggruppatoe  Tutte le proprietà le proprietà 

ordinate in modo logico secondo la frequenza d´uso invece che in ordine 

alfabetico.   

Ordinamento 

crescente e 

decrescente  

Mostra nelle visuali Raggruppatoe  Tutte le proprietà le proprietà 

ordinate in ordine alfabetico crescente o decrescente.   
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Apri/chiudi tutti 

i nodi  

Apre o chiude nelle visuali Raggruppato e  Tutte le proprietàtutti i 

nodi.  

 il nodo delle proprietà attualmente selezionate rimane 

aperto cliccando su Chiudi tutti i nodi.  

Mostra guida 

delle proprietà 

(auf Seite 148) 

Mostra la guida integrata che concerne le proprietà (guida delle 

proprietà).  

Rendi disponibili 

proprietà 

Simboli: rende disponibile la Proprietà selezionata. 

Opzioni barra 

strumenti  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso 

del menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli 

strumenti può essere chiusa cliccando sul pulsante X. 

 

 

7. Barra menù 

La barra menù contiene (a seconda del modulo ed elemento selezionati) liste a cascata per i seguenti 

elementi. 

BASE 

 

 File 

 Modifica 

 Immagini 

 Opzioni 

 Finestra 
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 Guida 

IMMAGINI E SIMBOLI 

Non appena viene aperta un´immagine, nuovi punti di menu completano la barra: 

 

 Elementi 

 Elementi di controllo 

Se viene attivata la Libreria simboli globale, il punto menu immagini viene sostituito da simboli. 

REPORT 

 

Se si apre un Rapporto: 

 il menu Immagini viene sostituito da Report 

 viene inoltre aggiunto il menu Formato 

 i comandi del menu Modifica (auf Seite 59) vengono sostituiti 

 

 

7.1 File 

Sono disponibili le seguenti azioni:   
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Punto di menu Azione 

Progetto Apre il dialogo che serve a creare un nuovo progetto. 

Inserisci progetto 

esistente 
Apre il dialogo che serve ad inserire un progetto esistente nell´editor.  

Inserisci progetto  

5.50 
Apre il dialogo che serve ad inserire un progetto realizzato con l´editor 

della versione 5.50. 

Ripristina backup di 

progetto  
Apre il dialogo che serve a caricare lo stato di un progetto salvato in un 

backup. 

Workspace   

nuovo Apre il dialogo che serve a creare un nuovo workspace.  

Apri  Apre il dialogo che serve a caricare un workspace già esistente.  

Salva  Salva l’area di lavoro corrente. 

Salva con nome  Salva l'attuale workspace. Potete indicare il nome e il luogo in cui 

effettuare il salvataggio. 

Chiudi  Chiudi l’attuale area di lavoro.  

Crea backup Apre il dialogo che serve a salvare tutti i progetti del worspace attuale. Il 

backup viene salvato in un file compresso *.wsb.  

Ripristina Backup  Apre il dialogo che serve a caricare i progetti salvati in un backup del 

wokspace. 

Configurazione 

generale  
 

Registra prodotto  Aprei il dialogo Registrazione del prodotto che serve all´inserimento del 

numero di serie e di quello di attivazione, oppure a richidere una licenza 

soft. 

Standard  Apre il dialogo che serve alla Configurazione delle impostazioni standard 

per i luoghi in cui salvare i dati e per le stampanti  

 AML 

 CEL 

 Valori 

 Protocolli 

 Hardcopy  
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 Blocco note 

Pannello di controllo Apre il pannello di controllo del sistema operativo. 

Crea Printscreen  L'intero contenuto dello schermo viene stampato mediante la stampata 

che è stata selezionata come standard. Proprietà di stampa sotto File -> 

Configurazione generale -> Standard. In un sistema a più monitor, viene 

stampato sempre lo schermo 1. 

Editor Visual Basic  Apre l’editor di Visual Basic 

 questo punto di menu esiste solamente se avete attivato VBA 

VSTA nel file zenon6.ini. Attivate VBA assicurandovi che nel settore 

[VBA] sia presente l´inserimento EIN=1. 

Wizard Apre il dialogo che serve alla selezione di un assistente. 

 questo punto di menu esiste solamente se avete attivato VBA 

VSTA nel file zenon6.ini. Attivate VBA assicurandovi che nel settore 

[VBA] sia presente l´inserimento EIN=1. 

Aggiornamento Wizards Apre il dialogo che serve ad effettuare l´update di un wizard. I dettagli li 

trovate nel capitolo Wizard, capitolo  Update dei wizard. 

 questo punto di menu esiste solamente se avete attivato VBA 

VSTA nel file zenon6.ini. Attivate VBA assicurandovi che nel settore 

[VBA] sia presente l´inserimento EIN=1. 

Workspace esistenti Presenta una lista dei workspace esistenti. Vengono indicati gli ultimi 5 

workspace selezionati.  

Termina  Chiude l´editor di zenon. 

 

 

7.2 Modifica 

IMMAGINI E SIMBOLI 

Se si seleziona un´immagine o un simbolo, il menu Modifica mette a disposizione dell´utente delle 

funzioni speciali.   

Sono disponibili le seguenti azioni:   
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Punto di menu Azione 

Annulla  Annulla l’ultima azione. 

Il numero delle azioni che è possibile annullare viene definito 

alla voce Opzioni -> Impostazioni . 

 Nell´editor dei modelli non è possibile annullare 

delle azioni.  

Taglia Taglia l’oggetto selezionato e lo salva negli appunti. 

Copiare  Taglia l’oggetto selezionato e lo salva negli appunti. 

Inserisci  Incolla un oggetto tagliato o copiato negli Appunti. Gli elementi 

vengono inseriti sempre centrati nella sezione di lavoro. Nel caso 

ci siano diversi oggetti, la posizione reciproca degli oggetti 

rimane la stessa.  

Inserisci nella 

stessa posizione 
La copia dell´oggetto viene incollata nella stessa posizinoe come 

nell´originale. 

Elimina  Elimina l’oggetto selezionato. 

Seleziona Tutto  Seleziona tutti gli oggetti nella finestra principale. 

Proprietà  Apre la finestra proprietà. 

Sostituisci 

collegamenti 
Apre il dialogo per sostituire delle variabili o funzioni collegate 

con elementi dinamici.  Dettagli:  vedi capitolo Sostituzione di 

variabili di processo in elementi dinamici. 

Posizione elemento Modifica la posizione degli elementi selezionati.  

Tasto ALT+ clic con il tasto sinistro del mouse 

seleziona elmenti da livelli inferiori. 
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Primo piano  Porta gli elementi selezionati in primo piano. 

Sfondo  Porta gli elementi selezionati sullo sfondo. 

Avanti  Porta gli elmenti selezionati avanti di un livello. 

Indietro  Porta gli elmenti selezionati indietro di un livello. 

Layout  Riposiziona gli elementi selezionati. 

Sinistra  Gli elementi selezionati vengono allineati a sinistra. 

Destra  Gli elementi selezionati vengono allineati a destra. 

In sù  Gli elementi selezionati vengono allineati in alto. 

In giù  Gli elementi selezionati vengono allineati in basso. 

Allinea  Riordina elementi. Punto di riferimento è il primo elemento 

selezionato. 
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Stessa larghezza  Gli elementi selezionati vengono adattati alla larghezza del 

primo elemento selezionato. 

 nel caso di elementi ruotati, la larghezza si orienta 

sempre alle coordinate ottiche, non a quelle logiche. Per i 

dettagli vedi capitolo Barra simboli Orientamento (auf Seite 31).  

Stessa altezza  Gli elementi selezionati vengono adattati all´altezza del primo 

elemento selezionato.  

 nel caso di elementi ruotati, l´altezza si orienta sempre 

alle coordinate ottiche, non a quelle logiche. Per i dettagli vedi 

capitolo Barra simboli Orientamento (auf Seite 31).  

Stesse dimensioni Gli elementi selezionati vengono adattati all´altezza  e alla 

larghezza del primo elemento selezionato.  

 nel caso di elementi ruotati, la grandezza si orienta 

sempre alle coordinate ottiche, non a quelle logiche. Per i 

dettagli vedi capitolo Barra simboli Orientamento (auf Seite 31).  

Centra 

orizzontalmente 

Gli elementi selezionati vengono allineati orizzontalmente al 

centro del primo elemento selezionato. 

Centra 

verticalmente  

Gli elementi selezionati vengono allineati verticalmente al centro 

del primo elemento selezionato. 

Stessa distanza x  Gli elementi selezionati vengono ordinati in modo tale che la 

distanza fra di loro sull´asse X sia uguale; i primi due elementi 

determinano la distanza. 

Stessa distanza y  Gli elementi selezionati vengono ordinati in modo tale che la 

distanza fra di loro sull´asse Y sia uguale; i primi due elementi 

determinano la distanza. 

Stessa spaziatura y Distribuisce tutti gli elementi selezionati lungo l´asse x fra i due 

elementi che sono stati selezionati per primi. Per questa opzione 

devono essere selezionati almeno tre elementi. 

Stessa spaziatura y Distribuisce tutti gli elementi selezionati lungo l´asse y fra i due 

elementi che sono stati selezionati per primi. Per questa opzione 

devono essere selezionati almeno tre elementi. 
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Rifletti orizz.  Rispecchia l´elemento selezionato su un´asse orizzontale. 

Rifletti vertic.  Rispecchia l´elemento selezionato su un´asse verticale. 

Gira 90°  Gira l´elemento selezionato di 90° in senso antiorario. 

Ordine tastiera 

sinistra/destra  

Mostra un modello con il quale viene stabilita la successione 

orizzontale nella quale si passa agli elementi ad immagine 

mediante la funzioneSetta focus. 

Ordine tastiera 

su/giù  

Mostra un modello con il quale viene stabilita la successione 

verticale nella quale si passa agli elementi ad immagine 

mediante la funzioneSetta focus. 

Simbolo   

Crea simbolo  Crea un nuovo simbolo da tutti gli elementi selezionati. 

Sciogli simbolo  Il simbolo viene diviso nei suoi elementi originari; il simbolo non 

esiste più. 

Modalità di 

modifica singola 

simbolo / elemento 

Consente di modificare i singoli elementi di un simbolo. Passa tra 

modalità di editazione oggetti singola e modalità editazione 

simbolo 

Incolla nel simbolo 

esistente.  

Apre la barra dei simboli per aggiungere il simbolo attivo in un 

simbolo della lista. 

Elimina da un 

simbolo. 

Elimina l´elemento selezionato dal simbolo attivo. Poi l´elemento 

non appartiene più al simbolo. 

Conversione simbolo 

collegato in 

simbolo 

indipendente  

Converte un simbolo da collegato a uno non collegato. Il simbolo 

perde, dunque, il suo collegamento con quello originale nella 

libreria e può essere modificato solo localmente. Questa 

conversione non può essere annullata. 

Lista Simboli  Apre una lista di tutti i simboli che sono visualizzati 

nell'immagine attuale.  Per ogni simbolo vengono indicate in una 

lista le sue singole componenti grafiche.  

Modifica 

ordinamento per il 

focus 

Apre la lista dropdown che serve a stabilire la successione 

orizzontale o verticale per la Gestione tastiera. 



Barra menù 

 

 

64 

 

 

Ordinamento 

sinistra/destra 
Stabilisce la successione orizzontale. 

Ordintamento 

alto/basso 
Stabilisce la successione verticale.  

Per i Rapporti, il menu Modifica mette a disposizione i seguenti inserimenti:  

Comando Descrizione 

Taglia Taglia l´area evidenziata e la copia negli appunti. 

Copiare Aggiunge il contenuto degli appunti. 

Inserisci Copia l´area evidenziata negli appunti. 

Incolla speciale Mette a disposizione delle opzioni di inserimento estese per operazioni 

cella: 

 Tutto Inserisce tutto quanto contenuto negli appunti. 

 Formule Inserisce solamente formule 

 Valore Inserisce solamente valori Va perso il riferimento alle formule. 

 Formato Riprende solamente il formato. 

Riempi Copia il contenuto della prima cella di una selezione e lo trasferisce in tutte 

le altre celle.  

 in giù Il riempimento avviene dall´alto in basso. 

 a destra Il riempimento avviene verso destra. 

Rimuovi Cancella dalle celle selezionate: 

 Tutto tutto 

 Contenuto Solo contenuti. 

 Formato Solo formati. 
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Cancella colonna/riga Cancella le colonne o le righe selezionate. 

Inserisci colonna riga Inserisce nuove colonne o righe. L´inserimento avviene sopra la riga o a 

destra della colonna. Viene aggiunto un numero di righe/colonne pari a 

quello evidenziato nel foglio elettronico. 

Cerca/Sostituisci Apre il Dialogo che serve alla ricerca e sostituzione nel foglio elettronico. 

 
 

7.3 Immagini 

Sono disponibili le seguenti azioni:   

Punto di menu Azione 

Salva immagine Salva l'immagine attuale.  

Salva tutte le 

immagini 

Salva tutte le immagini.  

Ridisegna immagine Attualizza la visualizzazione dello schermo.  

Mostra la griglia: Visualizza o nasconde la griglia.  

Utilizza griglia  Visualizza o nasconde la griglia.  

On: Tutti gli oggetti vengono allineati automaticamente alla griglia.  

Usa punti di appiglio Attiva o disattiva i punti di appiglio 

Usa:  se si avvicina un oggetto al punto di appiglio di un altro oggetti, l´oggetto si 

aggancia a questo punto di appiglio.  

Zoom Modifica la grandezza della visualizzazione in percentuali definite fra 15 % e 400 

%. 

Stampa screenshot 

dell´immagine 

attuale. 

L'immagine attuale viene stampata mediante la stampante che è stata 

selezionata come standard.  Proprietà di stampa sotto File -> Configurazione 

generale -> Standard. 

Inserisci grafica 

vettoriale 

Apre il dialogo che serve ad inserire una grafica vettoriale esterna.  
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  Informazioni 

Non appena è attivo un elemento ad immagine, viene visualizzato il menu Elementi. 

Esso mette a disposizione dell´utente tutti gli Elementi vettoriali e gli Elementi 

dinamici in modo analogo alla barra dei simboli Elementi. Se si selezionano degli 

speciali Tipi d´immagine, viene visualizzato anche il menu Elementi di controllo. 

Questo menu mette a disposizione dell´utente quegli elementi di controllo che sono 

relativi al tipo d´immagine selezionato.  

 

 

7.4 Simbolo 

Sono disponibili le seguenti azioni:   
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Punto di menu Azione 

Salva simbolo Salva il simbolo attuale. 

Salva tutti i simboli Salva tutti simboli. 

Modifica grandezza 

simbolo / colore di 

sfondo 

Apre il dialogo per la configurazione della grandezza simbolo e del 

colore di sfondo.  

 Le modifiche del colore di sfondo riguardano sempre tutti i 

simboli nella libreria simboli globale. 

Lista Simboli Apre una lista di tutti i simboli che sono visualizzati 

nell'immagine attuale.  Per ogni simbolo vengono indicate 

in una lista le sue singole componenti grafiche.  

Modalità schermo 

intero 

La modalità schermo intero esclude tutte le altre finestre e 

mostra solamente quella principale con tutti i documenti aperti 

(immagini, rapporti ....) in forma di immagine piena che occupa 

tutto lo schermo.  

La modalità schermo intero può essere terminata tramite: 

 il pulsante visualizzato per chiudere la modalità 

schermo intero  

 la combinazione tasti Shift +F9  

 il tasto Esc  

 

Ridisegna simbolo Attualizza la visualizzazione dello schermo. 

Mostra griglia Visualizza o nasconde la griglia. 

Utilizza la griglia Visualizza o nasconde la griglia.  

on: Tutti gli oggetti vengono allineati automaticamente alla 

griglia. 

Utilizza ancoraggio 

tra elementi vicini 

Attiva o disattiva i punti di appiglio 

Usa: se si avvicina un oggetto al punto di appiglio di un altro 

oggetti, l´oggetto si aggancia a questo punto di appiglio. 

Modifica ordinamento 

per il focus 

Apre la lista dropdown che serve a stabilire la successione 

orizzontale o verticale per la Gestione tastiera. 

Successione per sinistra/destra: Stabilisce la 
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successione orizzontale.  

Successione per sopra/sotto: Stabilisce la 

successione verticale.  

Zoom Modifica la grandezza della visualizzazione in percentuali definite 

fra 15 % e 400 %. 

Stampa Screenshot Il simbolo attuale viene stampata mediante la stampante che è 

stata selezionata come standard. Proprietà di stampa sotto File -> 

Configurazione generale -> Standard. 

Inserisci grafica 

vettoriale 

Apre il dialogo che serve ad inserire una grafica vettoriale 

esterna. 

 

 

7.5 Finestra 

Sono disponibili le seguenti azioni:   
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Punto di menu Azione 

Modalità schermo 

intero  

La modalità schermo intero esclude tutte le altre finestre e mostra solamente 

quella principale con tutti i documenti aperti (immagini, rapporti ....) in forma 

di immagine piena che occupa tutto lo schermo.  

La modalità schermo intero può essere terminata tramite: 

 il pulsante visualizzato per chiudere la modalità schermo intero  

 la combinazione tasti Shift +F9  

 il tasto Esc  

 

Esci  Chiudi la finestra attiva.  

Dividi  Suddivide la finestra principale e ordina le finestre attive in modo 

corrispondente.  

Lista delle 

finestre 
Mostra le finestre aperte. Al massimo vengono inserite nella lista 9 finestre. 

Finestra Apre il dialogo che serve a gestire le finestre in quella principale: 

 Attivare 

 salvare (possibile un multiselect) 

 chiudere (possibile un multiselect) 

La finestra attiva verrà preselezionata. 

 

 

7.6 Guida 

Sono disponibili le seguenti azioni:   
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Punto di menu Azione 

Informazioni su  Aprite una finestra con informazioni su zenon:  

 Numero di serie 

 Numero di attivazione 

 TAGs/IOs con licenza  

 moduli con licenza 

Potete navigare all´interno della finestra-info servendovi di una barra di 

scorrimento. Cliccando all´interno della finestra o premendo il tasto Esc si 

esce dalla finestra-info. 

Getting Started  Apre il capitolo Tutorials della guida in linea 

Guida  Richiama la guida in linea 

 

 

7.7 Opzioni 

Sono disponibili le seguenti azioni:   
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Punto di menu Azione 

Impostazioni Apre il dialogo che serve alla configurazione delle Impostazioni 

generali  (auf Seite 72), Menu (auf Seite 75), Barra simboli (auf Seite 

79) e Comandi (auf Seite 77). 

Editor Gestire profili 

editor 
Apre il Sottomenu (auf Seite 86) che serve alla gestione dei profili 

editor. 

Finestra principale con 

schede  
Mostra o nasconde nella finestra principale la visuale immagine 

multipla facendo uso di schede. 

Riga di stato Mostra o nasconde la Barra di stato dell´Editor. Essa non è 

identica alla barra di stato della visualizzazione dettagliata  (auf 

Seite 92) del Manager di progetto. 

Manager di progetto Mostra la finestra Manager di progetto (auf Seite 89). 

Finestra di emissione Mostra la finestra Finestra di emissione (auf Seite 149). 

Lista incrociata Mostra la Lista riferimenti incrociati. 

Finestra proprietà Mostra la finestra Finestra proprietà (auf Seite 141). 

Guida delle proprietà Mostra la finestra con la Guida delle proprietà (auf Seite 148). 

Toolbar Lista a cascata per visualizzare/escludere le barre simboli. 

Update del Runtime Windows 

CE 
Apre il software che serve per l´update di un runtime Windows CE. 

Definisci nuovo inserimento 

menu 
Apre il dialogo per implementare programmi esterni come propri 

inserimenti menu. 

 nel caso in cui sia già stato impostato un ulteriore 

inserimento di menu, quest´ultimo viene visualizzato in questa 

sede. Nuovi e ulteriori inserimenti menu vengono creati alla voce 

Opzioni -> Impostazioni -> Menu Tools (auf Seite 75). 
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7.7.1 Impostazioni 

Nel dialogo Impostazioni potete fissare le impostazioni di base per zenon. 

 

Opzioni Azione 

Editor e Runtime  

Lingua selezionata Scegliete la lingua per la superficie dell´editor. Per effettuare un 

cambio di lingua, l´editor deve essere riavviato.  La lingua standard 

dell´editor e l´inglese.  

Cornice di 

elementi dinamici 
Attivo: rappresenta gli elementi dinamici con una cornice di 

posizione. Potete differenziare fra editor e runtime.  

Non inviare 

rapporto di errore 

e Microsoft.  

Attivo: impedisce in caso di interruzione del funzionamento del 

programma l´invio di un rapporto di errore a Microsoft. 

Editor Opzioni  

Caricare l’ultimo 

workspace attivo: 
Attivo: all’avvio dell’editor verranno caricate le ultime aree di 

lavoro attive, visualizzate in una struttura ad albero. (Default) 

Non attivo: all´avvio dell´editor non viene caricato nessun 

workspace. Facendo uso del menu contestuale, potete aprire dei 
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progetti e workspace esistenti, oppure ne se può creare degli altri.  

Filtro nella 

visualizzazione 

dettagliata tiene 

conto della 

scrittura 

maiuscole / 

minuscola.  

Attivo: il filtro nella visualizzazione a lista distingue fra lettere 

maiuscole e minuscole.  

Non attivo: il filtro nella visualizzazione a lista considera allo 

stesso modo lettere maiuscole e minuscole (Default). 

Classificazione 

logica di testi 

nella sezione 

lista  

Attivo: nomi file contenenti numeri vengono ordinati secondo un 

criterio logico nella visualizzazione a lista, per es. 1, 2, 10, 11 

Inattivo:  nomi file contenenti numeri vengono ordinati secondo 

un criterio alfabetico nella visualizzazione a lista, per es. 1, 10, 11, 2 

Usa assistente Attivo: quando si vuole creare degli Archivi, Elementi 

combinati e Slider universale, il sistema offre automaticamente 

l´aiuto di un assistente. 

Disattivato: Archivi, Elementi combinati e Slider 

universale vengono configurati manualmente.   

Modifica immagini  

Apri proprietà 

oggetto 

automaticamente 

Attivo: Se create un elemento dinamico, si aprono 

automaticamente i box di dialogo per le impostazioni dettagli, come, 

ad esempio, quello che serve alla selezione delle variabil 

Disattivato: L´elemento dinamico viene disegnato, mentre le 

sue proprietà devono essere definite separatamente.   

Dialogo "Adatta 

collegamenti" per 

l´inserimento di 

simboli.  

Attivo: Quando si inserisce un simbolo in un´immagine, si apre il 

dialogo Adatta collegamenti.  

Disattivato: Il dialogo non viene aperto.  Dei collegamenti 

possono essere sostituiti in qualsiasi momento facendo uso del 

comando Sostituisci collegamenti che potete trovare nel menu 

contestuale.    

Distanza in pixel 

perché si 

verifichi un 

cambiamento di 

posizione.  

Intende evitare uno spostamento involontario di elementi.  Prima che 

un elemento venga effettivamente spostato, esso deve essere mosso 

perlomento per uno spazio che corrisponde al numero di pixel indicato.   

Quantità di azioni 

annullabili 
Permette di annullare fino a 100 azioni.  Di default possono essere 

annullate fino a 10 azioni. Indicate un numero fra 1 e100.  

Griglia Impostazioni  
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Mostra griglia Attiva: Mostra nella finestra principale la griglia definita alla voce 

Tipo di griglia. 

Inattivo: La griglia non è visualizzata. 

Posiziona sulla 

griglia 
Attiva: gli elementi ad immagine vengono sempre orientati 

secondo la griglia. Questa funzione è indipendente dall’opzione 

Mostra griglia. 

Colore griglia Definisce i colori della griglia. Per la selezione dei colori viene utlizzata 

la tavolozza di Wiindows. 

Tipo griglia Stabilisce il tipo della visualizzazione della griglia: continua, punteggiata 

oppure intersezioni. 

Distanza griglia 

[Pixel] 
Definisce la distanza orizzontale e verticale fra i singoli punti. In tal 

modo, si definisce anche quanto finemente devono essere 

rappresentate le dimensioni dell´elemento. Distanza griglia consigliata: 

10 pixel orizzontalmente e verticalmente. 

Punti di appiglio  

Usa punti di 

appiglio 

Gli elementi dispongono di punti di appiglio.  Se, spostando un oggetto, 

ci si avvicina al punto di appiglio di un altro, il punto di appiglio 

dell´oggetto selezionato ci si aggancia e si orienta rispetto ad esso.  

Grandezza dei 

punti di appiglio 

delle immagini 

Definisce la grandezza dello spazio di aggancio in pixel (angoli 

quadrati).  Indicate un numero fra 1 e 20.   

Grandezza dei 

punti di 

connessione 

nell'editor dei 

modelli  

Definisce la grandezza dello spazio di appiglio in pixel (angoli quadrati) 

per l´orientamento di modelli ad altri modelli, oppure ai margini dello 

schermo.  Indicate un numero fra 1 e 40.   

Angoli  

Inverti colori di 

sfondo: 

Attivo: Il colore degli angoli viene impostato in contrasto con lo 

sfondo attuale.  

Dimensione angoli Defnisce la grandezza in pixel degli angoli quadrati che servono per 

agganciare un elmemento.  Indicate un numero fra 1 e 20.   
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7.7.2 Menu tools 

Nel dialogo Menu Tools potete implementare dei programmi esterni nella struttura di menu dell´editor. 

I programmi integrati individualmente vengono mostrati alla fine del punto di menu Opzioni . 

 

Opzioni Azione 

Contenuti 

menu  

Mostra una lista dei programmi esterni già integrati.  

Nuovo  Aggiunge un nuovo inserimento di menu. 

Elimina  Elimina una voce di menu esistente.  

Sù  sposta verso l´alto l´inserimento di menu selezionato nella lista e nel menu. 

In giù  sposta verso il basso l´inserimento di menu selezionato nella lista e nel menu. 

Testo menu:  nome con il quale viene visualizzato il nuovo menu nelle opzioni. 

File  Nome e percorso del programma esterno che deve essere aperto (file *.exe).  

Parametri Ulteriore fattore per l´apertura del programma, per esempio un nome di file.  
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  Esempio 

Testo menu : Editor testo  

File: C:\Windows\notepad.exe 

Parametri: C:\test.txt 

Apre Notepad e il file test.exe. Se questo file non esiste, il sistema propone di generarlo. 

 

 

7.7.3 Schema colori 

In questo tab definite lo schema colore per l´editor. 
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Parametri Descrizione 

Schema colori per l'editor Cliccando sulla lista a cascata, aprite la lista con le 

possibilità fra cui effettuare la scelta. 

Anteprima Modifica lo schema colore dell´editor. La finestra di 

dialogo rimane aperta. 

OK Riprende e accetta le modifiche e chiude il dialogo. 

Annulla. Rifiuta le modifiche e chiude il dialogo. 

 

 

7.7.4 Comandi 

Nel dialogo Comandi definite quali comandi devono essere a disposizione nella barra dei simboli. 
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Opzioni Azione 

Categorie  Scelta della categoria che contiene il comando desiderato. 

Comandi Lista dei comandi a disposizione. 

Descrizione Testo per tooltip Se si porta il puntatore del mouse su un pulsante, una 

breve descrizione della funzione di quest´ultimo viene visualizzata sotto 

forma di tooltip. 

AGGIUNGI SIMBOLO 

1. aprite il menu  Opzioni -> Impostazioni -> Tab: Comandi (auf Seite 77) 

2. Selezionate nella finestra a sinistra una categoria. 

3. Cliccate nella finestra di destra con il tasto sinistro del mouse sul simbolo desiderato. 

4. tenendo premuto il tasto sinistro del mouse, trascinate il simbolo nella posizione desiderata 

nella barra dei simboli 

CANCELLA SIMBOLI 

1. aprite il menu  Opzioni -> Impostazioni -> Tab: Barra simboli (auf Seite 79) 

2. vengono attivati tutti i simboli di tutte le barre nell´editor  

3. Cliccate con il tasto sinistro del mouse sul simbolo.  

4. Trascinate il simbolo fuori dalla barra simboli e rilasciate il tasto del mouse. 

 

  Informazioni 

Per annullare delle modifiche apportate ad una barra simboli e per instaurare lo stato di 

fornitura, passate alla tab Barra simboli. Selezionate la barra dei simboli in 

questione e cliccate sul pulsante Ripristina, oppure su Ripristina tutto per far sì 

che tutte le barre dei simboli siano riportate allo stato di fornitura. 

 

 



Profili editor 

 

 

79 

 

 

7.7.5 Barre dei simboli 

Nel dialogo Barre simboli potete definire l´aspetto e la visibilità delle barre simboli.  

 

Opzioni Azione 

Barre dei simboli Checkbox attivo: la barra simboli viene visualizzata nell´editor.  

Annulla Ripristina lo stato di partenza per la barra simboli evidenziata  

Annulla tutto  Ripristina lo stato di partenza per tutte le barre simboli  

 
 

8. Profili editor 

L´editor si apre in un´impostazione standard con finestre predefinite. Potete ordinare e attivare le 

finestre a piacere. I dettagli relativi li potete trovare nel capitolo Adatta visualizzazione (auf Seite 12) 

Gestite le Vostre impostazioni individuali nei profili. Li raggiungete tramite  

 la barra dei simboli Profili editor  

(vedi: Gestisci profili editor nella barra dei simboli (auf Seite 84)) 
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 il sottopuntoGestisci profili editor nelle Opzioni della barra menu.   

(vedi Gestisci profili editor mediante il menu (auf Seite 86)) 

 Mediante delle combinazioni di tasti 

(vedi Gestisci profili editor con combinazioni di tasti (auf Seite 86)) 

Potete attribuire dei profili editor a dei singoli moduli  anche tramite menu contestuale (vedi Seleziona 

profili editor nel menu contestuale (auf Seite 87)) o potete usare dei profili predefiniti (auf Seite 80). 

  Informazioni 

Nel caso di finestre divise (come nel managerdi progetto, nella visuale generale e in 

quella dettagliata), la definizione della larghezza vale per la finestra nel suo complesso. 

Al momento dell´avvio e della chiusura dell`Editor, il sistema stabilisce la corretta 

relazione delle dimensioni della finestra stessa.  

Se la relazione reciproca degli elementi della finestra viene modificata, un´apertura di un 

profilo provoca solamente l´impostazione della finestra nel suo complesso in base ai 

valori definiti. La relazione reciproca fra visuale generale e dettagliata, per esempio, non 

viene modificata.  

 

 

8.1 Profili predefiniti 

In zenon sono a Vostra disposizione tre profili predefiniti. Ottimizzate il layout dell´editors con una 

risoluzione di 1280 x 1024 per: 

 Variabili e visualizzazione lista: profilo 1 spazio di memoria P1  

 Immagini: profilo 2 spazio di memoria P2  

 Standard per compiti generali: profilo 3 spazio di memoria P3.  

SELEZIONARE PROFILO PREDEFINITO 

Potete attivare o disattivare questi profili. A tal scopo usate o i Simboli (auf Seite 84) nella barra dei 

simboli per i profili editor, oppure: 

1. aprite il menu Opzioni. 
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2. cliccate su Gestisci profili editor  

 Carica profilo standard: carica i profili predefiniti sui primi tre posti di memoria e li 

collega ai moduli. Profili eventualmente già esistenti vengono sovrascritti. 

 Elimina attribuzioni di profili: Cancella tutti i collegamenti di profili predefiniti 

con i moduli. 

Per utilizzare i profili, selezionate in corrispondenza del modulo desiderato nel menu contestuale Profilo 

editor -> [Numero profilo]  

Se al momento della selezione di un profilo predefinito ricevete una segnalazione di errore con il 

rimando a zenAdminSrv, ciò può avere due cause: 

1. Il servizio zenAdminSrv funziona con un numero di versione inferiore a quello dell´editor attuale.  

Soluzione: sincronizzate il servizio.  

2. I profili sono stati eliminati dal percorso standard:  

Soluzione: copiate il file Predefined Editor Profiles.epf nella cartella 

C:\ProgramData\COPA-DATA\zenonxxx\EdProfiles (xxx corrisponde alla versione 

attuale di zenon). 
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PROFILI 

Rappresentazione ottimizzata per la modifica di variabili e visualizzazioni lista. 
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Rappresentazione ottimizzata per la modifica di immagini. 
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Visuale standard, ottimizzata per moduli che non si basano su liste. 

 
 

8.2 Gestisci profili editor con la barra dei simboli 

La barra dei simboli per i profili editor viene visualizzata nell´editor al centro della seconda riga di 

simboli (default).  Nel caso in cui sia stata disattivata, cliccate con il tasto destro del mouse accanto alla 

varra dei simboli e scegliete Profili editor. Riceverete la seguente barra simboli: 
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Simbolo  

(da sinistra a destra) 

Funzione 

Carica profilo editor 

selezionato 
Carica il profilo selezionato nel settore Seleziona profilo editor. 

Seleziona profilo 

editor 
Lista a cascata (auf Seite 88) con 10 profili. 

Carica profilo 

standard 
Resetta tutte le impostazioni relative a visualizzazione e posizione delle 

finestre, nonché contenuti e visualizzazione delle barre dei simboli e dello 

stato di emissione; poi carica il profilo standard di zenon. 

Carica Profili 

predefiniti: (auf Seite 

80) 

carica i profili predefiniti di COPA-DATA sui primi tre posti di memoria e li 

collega ai moduli.  Profili eventualmente già esistenti vengono sovrascritti.  

Elimina attribuzioni 

di profili: (auf Seite 80) 
Cancella tutti i collegamenti di profili predefiniti con i moduli.  

Salvataggio automatico 

dei profili editor  
Attivo: le modifiche del profilo attuale vengono salvate 

automaticamente al momento dell´apertura di un altro profilo.   

Disattivato: le modifiche non vengono salvate al momento del 

cambiamento di profilo; quando si richiama un´altra volta il profilo in 

questione, vengono riproposte le posizioni originali.   

Salva profilo editor 

selezionato 
Salva le impostazioni finestra attuali nel profilo che è visualizzato nel settore 

Seleziona profilo editor. 

Assegna nomi 

individuali ai profili 

editor.  

Apre un Dialogo (auf Seite 88) in cui possono essere assegnati dei nomi 

individuali ai profili editor.   

Opzioni per barre 

dei simboli  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso del 

menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli strumenti 

può essere chiusa cliccando sul pulsante X. 

Per esportare o importare dei profili editor, selezionate l´opzione corrispondente nel Menu principale 

(auf Seite 86) alla voce Opzioni -> Editor Gestisci profili editor. 
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8.3 Gestisci profili editor mediante il menu 

Per gestire i Vostri profili editor, selezionate nel menu Opzioni -> Editor Gestisci profili editor. 

Avete le seguenti possibilità:  

Opzioni Funzione 

Nomina Apre un Dialogo (auf Seite 88) in cui possono essere assegnati dei nomi 

individuali ai profili.   

Carica profilo 

standard 
Riporta tutte le impostazioni finestra allo standard di default e carica il 

profilo standard di zenon. 

Esportare Apre il Manager file e salva le impostazioni sotto forma di file .zip in un posto 

che può essere scelto liberamente.    

Importare Apre il Manager file al fine di importare delle impostazioni salvate sotto 

forma di un file .zip da un luogo qualsiasi nel quale le si era salvate.    

Per selezionare dei profili editor individuali o per salvarli, usate le funzioni corrispondenti della  Barra 

simboli  (auf Seite 84) o  Combinazioni di tasti (auf Seite 86). 

 

8.4 Gestisci profili editor con combinazioni di tasti 

Sono disponibili le seguenti azioni:   
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Comando  Combinazione tasti  

Carica profilo editor 1   Shift+F1  

Carica profilo editor 2  Shift+F2  

Carica profilo editor 3  Shift+F3  

Carica profilo editor 4  Shift+F4  

Carica profilo editor 5  Shift+F5  

Carica profilo editor 6  Shift+F6  

Carica profilo editor 7  Shift+F7  

Carica profilo editor 8  Shift+F8  

  

Salva visuale editor attuale come:  

Profilo editor 1 Ctrl+Shift+F1  

Profilo editor 2  Ctrl+Shift+F2  

Profilo editor 3 Ctrl+Shift+F3  

Profilo editor 4  Ctrl+Shift+F4  

Profilo editor 5  Ctrl+Shift+F5  

Profilo editor 6  Ctrl+Shift+F6  

Profilo editor 7  Ctrl+Shift+F7  

Profilo editor 8  Ctrl+Shift+F8  

 
 

8.5 Seleziona profili editor nel menu contestuale 

Nel Manager di progetto, per ogni progetto e ogni suo sottolivello possono essere selezionati e asegnati 

in modo duraturo dei profili editor facendo uso del menu contestuale:  cliccare con il tasto destro del mouse 

sul ramo > Seleziona  -> Profili editor.  

E´possibile eliminare una assegnazione scegliendo il punto 'nessuno' nel menu contestuale.  
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Questa preselezione é possibile per tutti i rami e moduli, fatta eccezione per il Energy Management 

System e la Libreria dei simboli globale. 

 

8.6 Elimina profili editor 

Per cancellare i Vostri dati profili: 

1. cancellate l´intera cartella Editor, nel percorso 

C:\Users\USERNAME\AppData\Local\COPA-DATA\zenon\Editor 

Nota: dovete sostituire lo USERNAME con il nome utente dello user Windows registrato. 

2. cancellate l´inserimento per il profilo nella Windows registry sotto:  

HKEY_CURRENT_USER\Software\COPA-DATA\Editor\Profiles  
 

8.7 Dialogo per nome dei profili editor 

Potete assegnare individualmente dei nomi ai profili editor:  direttamente nella Barra simboli (auf Seite 

84), tramite  Combinazione di tasti (auf Seite 86) oppure facendo uso di un dialogo.  Potete passare al 

dialogo in questione attraverso:  

 barra simboli, simbolo Assegna nome individuale per profili editor oppure 

 Menü -> Opzioni ->  Editor Gestisci profili editor -> Nomina  

 

Inserite nei campi dei nomi individuali digitandoli dopo la denominazione breve-profilo editor.  Facendo 

uso della combinazione di tasti Shift+F1 fino a  Shift+F8 potete aprire in qualsiasi momento i primi 8 
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profili nell´editor.  Oppure potete selezionare il profilo editor desiderato facendo uso del simbolo 

corrispondente nella Barra dei simboli (auf Seite 84). 

 

9. Manager di progetto 

Il Manager di progetto si trova di default sul margine sinistro dello schermo, direttamente sotto la barra 

dei simboli. La visualizzazione può avvenire in due modi: 

 Albero di progetto 

 Topologia di rete 

ALBERO DI PROGETTO 

La struttura ad albero del progetto contiene: 

 a sinistra, il workspace con i progetti e la Libreria dei simboli globale.: 

 Nel workspace si trovano tutti i progetti caricati con le loro variabili, funzioni, 

immagini ecc. 

 La libreria simboli globale contiene delle grafiche predefinite e offre la possibilità di 

creare delle nuove grafiche. 

 a destra una visione dettagliata: 

presenta una lista di tutti gli elementi e delle impostazioni per il settore della visione ad 

albero che è stata selezionata. 

TOPOLOGIA DI RETE 

La visuale Topologia di rete rappresenta topologicamente tutti i progetti nel workspace e permette di 

controllare tutte le componenti di rete coinvolte, nonché di effettuare un Trasporto Remoto dei file 

runtime ai computer connessi. 

Potete leggere i dettagli su questo argomento nella sezione Rete e in particolare nel capitolo Controlla la 

validità della Topologia di rete. 
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9.1 Workspace 

Nell´area di lavoro si amministrano le seguenti componenti di un progetto: 

 Variabili 

 Driver 

 Tipi di dato 

 Matrice di reazione 

 Attribuzioni 

 Allarme 

 Unità di misura 

 Immagini 

 Modelli 

 Carattere 

 Tavolozza colori 

 Simboli di progetto 

 Funzioni 

 Script 

 File per cambio lingua 

 Archiviazione 

 Ricette 

 Ricette standard 

 Manager gruppi di ricette 

 Temporizzatori 

 Scripting 

 Process Control Engine 

 Macro VBA 

 VSTA 

 zenon Logic è un ambiente di sviluppo per IEC 61131-3. 

 Production and Facility Scheduler  
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 Interblocchi 

 Comandi 

 Energy Management System 

 Message-Control  

 Menu  

 Generatore di rapporti  

 Gestione user 

 Interfaccia SAP 

 File: aggiunge file esterni. Essi non vengono modificati con zenon, ma con un programma 

esterno.  

 Grafica 

 Tabella lingua 

 Guida 

 Multimedia 

 Liste 

 Driver 

 Altri 

 Log delle modifiche  

 Backup progetto 

La disponibilità delle singole componenti può dipendere dalla licenza scelta. Potete verificare per quali 

moduli possedete la licenza cliccando su Help -> Info su.....  

Per eventuali estensioni della Vostra licenza Vi preghiamo di rivolgervi al Vostro distributore, oppure a 

sales@copadata.com.  

  Informazioni 

I singoli elementi del manager di progetto, come variabili e funzioni, possono essere 

visualizzati in una finestra propria. A questo scopo, cliccate nel menu contestuale su Apri 

in nuova finestra. In tal modo potete, ad esempio, modificare contemporaneamente 

variabili e funzioni.  

 



Manager di progetto 

 

 

92 

 

 

 

9.2 Sezione lista del manager di progetto 

Se si sceglie un elemento nella visione ad albero del Manager di progetto, la visualizzazione dettagli 

mostra tutti gli oggetti relativi e le loro proprietà. 

Nel caso di una visualizzazione a tabella, potete: 
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Azione Modo di procedere: 

Seleziona liberamente le 

colonne:  

clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale -> 

Seleziona colonna   

Modifica la larghezza di 

una colonna:  

 muovere il puntatore del mouse sulla linea di separazione nel titolo della colonna 

finché esso non assume la forma di una croce. 

 tenere premuto il tasto del mouse. 

 Trascinare la colonna finché non avrà la dimensione desiderata. 

Ordina colonne: un clic del mouse sul titolo colonna ordina la lista nel modo opposto all´ordine 

attuale (crescente/ decrescente).  

Formatta colonna clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale -> 

Formatta colonna   

Raggruppa proprietà clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale -> 

Raggruppa sulla base di questa colonna oppure 

clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale ->  

Annulla raggruppamento  

Adatta visualizzazione alla 

larghezza della finestra 

clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale -> 

Adatta la grandezza alla larghezza della colonna   

Elimina colonna clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale -> 

Elimina questa colonna   

MENU 

Comando Azione 

Crescente ordina colonna in senso crescente 

Decrescente ordina colonna in senso decrescente 

Raggruppa per questa colonna raggruppa elementi in relazione a questa colonna 

Annulla raggruppamento elimina il raggruppamento esistente 

Selezione colonne... apre il dialogo che serve alla selezione delle colonne 

che devono essere visualizzate 

Formatta colonna apre il dialogo che serve a formattare la colonna 

Aggiusta la dimensione alla larg. 

Finestra 
distribuisce tutte le colonne sull´intera finestra 

Elimina questa colonna elimina la colonna dalla visualizzazione 
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RIGA DI STATO 

Nel caso delle liste, la barra di stato della visualizzazione dettagliata mostra le informazioni sugli 

elementi esistenti, filtrati e selezionati. 

  Esempio 

Visualizzazione della barra di stato. Visualizzazione dettagliata: 39 nel complesso / 30 

filtrati / 2 selezionati significa 

 sono disponibili complessivamente 39 elementi 

 30 vengono visualizzati sulla base delle impostazioni di filtro che sono state 

adottate. 

 2 sono stati selezionati 

Nel caso delle variabili, viene anche visualizzato il numero dei TAGs o di  IOs utilizzati e provvisti di 

licenza.  

per esempio: 32 TAGs utilizzati/TAGs illimitati disponibili. 

  Informazioni 

Delle informazioni dettagliate concernenti la modifica e la gestione degli elementi, le 

trovate nel capitolo Modifica inserimenti (auf Seite 94) e nella descrizione 

dell´elemento in questione. 

 

 

9.2.1 Modifica inserimenti 

Per modificare degli inserimenti, sono a Vostra disposizione diverse possibilità: 
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percorso Procedura 

Barra dei simboli della 

sezione lista  

 Selezionate servendovi del tasto sinistro del mouse la cella desiderata.  

 Selezionate nella barra simboli il pulsante Modifica Celle selezionate.  

Menu  Cliccate con il tasto destro del mouse nella cella desiderata.  

 Selezionate nel menu contestuale l´inserimento Modifica cella 

selezionata.  

Doppio clic ritardato   Evidenziate la cella desiderata cliccando due volte a breve distanza di tempo 

(cliccare due volte lentamente).  

Finestra di proprietà   Selezionate l´elemento desiderato.  

 Impostate nella finestra Proprietà l'inserimento desiderato.  

Tasto F2   Selezionate servendovi del tasto sinistro del mouse la cella desiderata.  

 Premete il tasto F2.  

 

  Informazioni 

Cliccando in una cella, essa viene selezionata nella sua interezza. Riconoscete quali celle 

avete selezionato grazie al simbolo del binocolo che vedete nel titolo della colonna.  

 

  Attenzione 

Eccezioni 

 Nella visualizzazione dettagliata possono essere modificate solo quelle 

proprietà che sono modificabili anche nella finestra delle proprietà. Così, per 

esempio, non si può modificare il nome di una variabile di driver di sistema. 

 La storia delle modifiche non è modificabile a causa di quanto previsto dalle 

norme FDA. 

 Per quello che concerne i backup di progetto, è modificabile solo il nome del 

backup.  
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9.2.2 Barra dei simboli della sezione lista 

Al margine superiore della sezione lista, potete usare in una barra simboli tutte le funzioni che potete 

trovare anche nel menu contestuale. A seconda di cosa avete selezionato nella vista ad albero del 

progetto (ad esempio: immagini, variabili, simboli ecc.), vengono visualizzati differenti pulsanti nella 

barra dei simboli. 

Quei pulsanti che non è consentito utilizzare, sono disattivati e non reagiscono se ci si clicca sopra. 
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Num. Simbolo Azione 

01 Nuova Variabile  Apre il dialogo per la creazione di una nuova variabile. 

02 Copiare Copia gli inserimenti selezionati negli appunti 

03 Inserisci Aggiunge il contenuto degli appunti. Se un inserimento è già esistente 

con lo stesso nome, il contenuto viene aggiunto come "copia di". 

04 Elimina Cancella gli inserimenti selzionati. 

05 Crea funzione standard Apre l´assistente per la selezione delle variabili e dei valori impostabili 

e che crea una funzione adatta. L´azione viene documentata nella 

finestra di emissione. 

06 Modifica celle 

selezionate 

Apre la cella selezionata per effettuarne la modifica Vedete quale 

cella è stata selezionata in una riga evidenziata facendo riferimento al 

simbolo della lente di ingrandimento nella riga titolo. 

07 Sostituisci testo nella 

colonna selezionata... 

Apre il dialogo che serve alla ricerca e alla sostituzione di testi. 

08 Sostituisci testo in 

valore limite 

Apre il dialogo che serve a selezionare la proprietà dinamica e, di 

seguito, il dialogo che serve alla ricerca e alla sostituzione. 

09 Proprietà Apre l´immagine Proprietà per l´inserimento selezionato. 

10 Espandi tutto Lista a cascata per estedere tutti nodi o quelli selezionati, oppure per 

ridurli. 

11 Attiva Attiva gli elementi selezionati di una variabile struttura. 

12 Disattiva Disattiva gli elementi selezionati di una variabile struttura. 

13 Attiva tutte Attiva tutti gli elementi non attivi di una variabile struttura. 

14 Esporta selezione in 

XML 

Esporta tutti gli inserimenti in un file XML. 

15 Importa XML Importa file XML. 

16 Importazione variabili - 

S7 

Importa un progetto Simatic S7. 

17 Attiva attiva o disattiva impostazioni di filtro estese. 

18 Torna all'elemento di 

partenza 

Quando si è passati tramite la funzione Elementi collegati nella 

lista, il simbolo riporta all´elemento di partenza.  

Nel menu contestuale esistente solamente, se aperto come elemento 

collegato.   
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19 Elimina filtro Elimina tutte le impostazioni di filtro 

20 Guida Attiva la guida online 

Punto di menu Azione 

Nuova Variabile Apre il dialogo per la creazione di una nuova variabile. 

Copiare Copia gli inserimenti selezionati negli appunti 

Inserisci Aggiunge il contenuto degli appunti. Se un inserimento è già esistente 

con lo stesso nome, il contenuto viene aggiunto come "copia di". 

Elimina Cancella gli inserimenti selzionati. 

Crea funzione standard Apre il dialogo che serve alla selezione delle variabili e dei valori 

impostabili. 

Modifica celle 

selezionate 
Apre la cella selezionata per effettuarne la modifica Vedete quale cella 

è stata selezionata in una riga evidenziata facendo riferimento al 

simbolo della lente di ingrandimento nella riga titolo. 

Sostituisci testo nella 

colonna selezionata... 
Apre il dialogo che serve alla ricerca e alla sostituzione di testi. 

Sostituisci testo in 

valore limite 
Apre il dialogo che serve a selezionare la proprietà dinamica e, di 

seguito, il dialogo che serve alla ricerca e alla sostituzione. 

Proprietà Apre l´immagine Proprietà per l´inserimento selezionato. 

Espandi/riduci nodi Apre un sottomenu che serve ad estendere e chiudere i nodi. 

Attiva tutte Attiva tutti gli elementi non attivi di una variabile struttura. 

Attiva Attiva gli elementi selezionati di una variabile struttura. 

Disattiva Disattiva gli elementi selezionati di una variabile struttura. 

Esporta selezione in XML Esporta tutti gli inserimenti in un file XML. 

Importa XML Importa da file XML. 

Import/export esteso Apre il menu per importare ed esportare i progetti/S7, dBase und csv. 

Variabili utilizzate Realizza una  analisi di progetto delle variabili selezionate nel progetto 

attuale e la mostra in forma di Lista risultati in una finestra apposita. 

Filtro esteso Apre il sottomenu che serve ad attivare o a disattivare dei filtri, oppure 
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ad eliminare tutte le impostazioni di filtro. 

Elemento collegato Mostra gli elementi collegati con le variabili. 

Guida Attiva la guida online 

 
 

9.2.3 Navigazione nella sezione lista 

Per navigare in una lista: 

1. cliccate sulla colonna nella quale deve essere effettuata la ricerca. 

2. Toccate il primo segno per avviare la ricerca. Nel caso non esista nessun inserimento che inizia 

con questa lettera, la ricerca si interrompe immediatamente. 

3. L´inserimento trovato viene seletzionato. Appare un campo di inserimento. Il primo segno del 

testo di cella è evidenziato. 

 Potete indicare in questo campo dei criteri di ricerca, ma non potete moficare il 

nome dell´elemento. 

4. Indicate ulteriori caratteri per limitare la ricerca. Nel caso in cui non si trovi nessun inserimento 

adatto, il carattere digitato viene rifiutato e la selezione rimane alla posizione attuale. 

5. Nel caso in cui siano disponibili più inserimenti corrispondenti al criterio di ricerca, potete 

navigare con i tasti Ctrl+Su oppure Ctrl+ Giù. 

6. Con il tasto BACKSPACE  viene cancellato l´ultimo carattere del criterio di ricerca e viene avviata 

una nuova ricerca sulla base dei segni residui. Con la cancellazione dell´ultimo segno, la ricerca 

viene conclusa. 

ORDINAMENTO 

Per ordinare nella visuale a lista, potete selezionare anche più colonne contemporaneamente. 

1. cliccate nell´intestazione della colonna con il primo criterio di ordinamento 

2. tenete premuto il tasto shift e cliccate sul titolo della colonna con il secondo criterio di 

ordinamento; 
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3. In tal modo, potete aggiungere un numero qualsiasi di colonne 

Ad esempio: ordinamento sulla base di blocco dati e offset mostra in primo luogo tutti i 

blocchi dati e tutti gli indirizzi relativi ordinati in modo corretto. 

 cliccando una seconda volta sul titolo della colonna si cambia la successione 

dell´ordinamento 

 

9.2.4 Filtra inserimenti lista 

Elementi della visualizzazione dettagliata possono essere filtrati e ordinati secondo diversi criteri. 

Mediante il pulsante Elimina tutti i filtri nella lista simboli della visualizzazione dettagliata 

oppure il comando Elimina tutti i filtri nel menu contestuale, vengono azzerate tutte le 

impostazioni di fultro. 
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Stile Procedura 

Classificazione in 

ordine alfabetico  

Clic del mouse sul titolo di una colonna: La lista viene ordinata secondo la colonna 

corrispondente. Un secondo clic con il mouse sul titolo della colonna, inverte l'ordine 

di ordinamento. 

Assegnazione dei 

criteri di filtro  

Direttamente sotto il titolo della colonna si trova un campo per l´impostazione dei 

criteri di filtro. In questa sede vengono indicati dei criteri. 

Poi verrano visualizzati solamente quegli oggetti che corrispondono al criterio di filtro 

indicato. 

Per far sì che vengano visualizzati di nuovo tutti gli oggetti, bisogna eliminare il criterio 

di filtro. 

Cliccando nel settore filtro si apre una lista dropdown che contiene i filtri usati per 

ultimi di questa colonna. 

Filtra secondo i 

checkbox  

Liste con checkbox (per es. templates) possono essere ordinati e filtrati in checkbox 

attive e non attive. 

Ciò funziona allo stesso modo della classificazione in ordine alfabetico. 

Per effettuare il filtraggio trovate in una cella sotto il titolo della colonna una lista 

dropdown con la selezione di checkbox attive, inattive o tutte. 

Caratteri jolly  Per i criteri di filtro sono a disposizione caratteri simbolici: 

 * sostituisce una successione di segni. 

Esempio: *1 filtra cercando gli elementi che finiscono con il segno 1 per esempio 

Variabile 1.  

Le wildcard possono essere usate solamente come prefisso o suffisso. 

 ? sostituisce un unico segni. 

Esempio: Variabile? filtra tutti gli elementi che iniziano con la successione di caratteri 

Variabile e che hanno un ulteriore segno, per esempio Variabile1, Variabile 

2, Variabile 3 ... 

Collegamento 

logico 

Le parole filtro possono essere collegate mediante espressioni logiche, quali, ad 

esempio, AND e OR. Ciò funziona anche nel caso si utilizzino delle wildcard (*), ma non 

nel caso di caratteri jolly per singoli segni (?). 

Contenuti della 

cella come 

criterio di filtro  

Le parole o le successioni di segni di un cella della visualizzazione dettagliata possono 

essere utilizzati come criterio di filtro: 

 Selezionate l´inserimento desiderato. 

 Tenete premuto il tasto ALT e cliccate sulla cella. 

 L´inserimento viene reso disponibile in un campo di editazione. 
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 Selezionate una qualsiasi successione di segni facendo uso del mouse. 

 Trascinate la parte selezionata tenendo premuto il tasto sinistro del mouse (Drag&Drop) 

sulla cella di filtro del capo della colonna. 

 La successione di caratteri scelta viene presa come nuovo testo di filtro. 

Effetto del filtro 
Elementi 

collegati 

Facendo uso dell´opzione Elementi collegati è possibile visualizzare quegli 

elementi che sono collegati con l´elemento attuale. Se con questa opzione si passa ad 

un elemento della visualizzazione dettagliate, per esempio ad una variabile, esso viene 

mostrato indipendentemente dalle impostazioni di filtro attuali. Se non è contenuto 

nel filtro attuale, viene comunque indicato alla fine della lista e viene selezionato 

automaticamente. 

Modifica 

proprietà  

Dopo aver creato o selezionato un oggetto nella sezione lista o tramite il menu 

contestuale, i suoi parametri possono essere definiti o modificati nella finestra 

proprietà. 

Sono consentite inoltre selezioni multiple. Nel caso dovessero essere stati selezionati 

contemporaneamente più oggetti, possono essere modificate nello stesso tempo le 

loro proprietà. 

Inserimenti e modifiche nella finestra delle proprietà valgono per tutti gli oggetti 

evidenziati. Gli inserimenti validi fino ad allora vengono sovrascritti. Nella finestra 

proprietà, però, sono a disposizione solo quelle proprietà che valgono per tutti gli 

inserimenti selezionati. 

Filtri estesi per le 

variabili 

Per le variabili è disponibile un dialogo per raffinare i filtri. Passate a questo filtro nel 

seguente modo: 

 con il simbolo Attiva filtri estesi  nella barra dei simboli nella visualizzazione 

dettagliata oppure 

 con il comando filtri estesi nel menu contestuale 

I filtri standard vengono estesi con gli elementi Tipi di dato, Flag di selezione 

e Filtro stringa (nome variabili, identificazione, matrice di reazione). 

 

 

9.2.5 Sostituisci testo nella colonna selezionata... 

zenon supporta la funzionalità Cerca/sostituisci per le string (per esempio, nome immagine, nome 

variabile, identificazione variabile):  Potete sostituire dei testi in colonne attive e in valori limite.  



Manager di progetto 

 

 

103 

 

 

  Attenzione 

Si tiene conto solamente dei testi che si trovano in strutture aperte (variabili o tipi di 

dato).  Le strutture chiuse non sono destinazioni per l´editor come destinazioni e, prima di 

iniziare la ricerca, bisogna estenderla.  

SOSTITUISCI TESTO NELLA COLONNA SELEZIONATA: 

1. Attivate il dialogo facendo uso del simbolo Sostituisci testo nella colonna selezionata, 

oppure usando il comando del menu contestuale che ha lo stesso nome.  

2. Definite nel dialogo i parameteri per la ricerca e la sostituzione.  

3. Le sostituzioni vengono effettuate nella colonna attiva.  Riconoscete qual è la colonna attiva 

vedendo il simbolo Binocolo accanto al titolo della colonna. 

 

  Attenzione 

Viene usato nella identificazione variabili Cambio immagine (riconoscibile a causa della 

parola chiave @), al fine di una ricerca e sostituzione corretta deve essere attiva la 

prorietà di progetto Visualizzare parole chiave non tradotte. Per attivarla:  

 passate alla proprietà di progetto, in particolare al nodo Aspetto grafico  

 attivate la checkbox della proprietà Visualizzare parole chiave non tradotte 
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9.2.6 Sostituisci testo in valori limite 

Per sostituire testi in valori limite:  

 attivate il dialogo facendo uso del simbolo Sostituisci testi in valori limite, oppure usando il 

comando del menu contestuale che ha lo stesso nome.  

 Selezionate nella finestra di selezione la proprietà dinamica desiderata.  

 

 Passate così al dialogo per Sostituisci testo in valori limite. 

 

  Attenzione 

Si tiene conto solamente dei testi che si trovano in strutture aperte (variabili o tipi di 

dato).  Le strutture chiuse non sono destinazioni per l´editor come destinazioni e, prima di 

iniziare la ricerca, bisogna estenderla.  
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9.2.7 Mostra e nascondi colonne 

Le colonne disponibili nella visualizzazione dettagliata possono essere mostrate e nascoste a piacere e 

possono essere ordinare in qualsiasi successione vogliate. Per alcune immagini, le seguenti impostazioni 

possono essere realizzate anche facendo uso di dialoghi di cambio immagine. 

MOSTRA E NASCONDI COLONNE 

1. Cliccate con il tasto destro del mouse su un titolo di una colonna  

2. e selezionate nel menu contestuale Selezione colonne 

3. nel seguente dialogo selezionate Mostra Nascondi colonne: 

potete selezionare più colonne (esattamente come usuale nel sistema operativo) tenendo 

premuto Shift oppure Ctrl 

4. Colonne disponibili realizza una lista di tutte le colonne ancora disponibili. Colonne 

selezionate mostra tutte le colonne attive. 
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Pulsanti Funzione 

Aggiungi Sposta le colonne selezionate da quelle disponibili a quelle selezionate. Dopo aver 

confermato il dialogo cliccando su OK, esse vengono visualizzate nella visualizzazione 

dettagliata. 

Aggiungi tutte Sposta tutte le colonne disponibili nelle colonne selezionate. 

Rimuovi Elimina le colonne evidenziate dalle selezionate e le visualizza nella lista di quelle 

disponibili. Dopo aver confermato il dialogo cliccando su OK, esse vengono eliminate 

dalla visualizzazione dettagliata. 

Cancella tutte Cancella tutti le colonne  dalla lista delle colonne scelte. 

in sù Sposta l´inserimento selezionato verso l´alto. Questa funzione è sempre disponibile 

per inserimenti singoli,  non è possibile però nel caso di una selezione multipla. 

in giù Sposta l´inserimento selezionato verso il basso. Questa funzione è sempre disponibile 

per inserimenti singoli,  non è possibile però nel caso di una selezione multipla. 

OK Riprende le impostazioni e chiude il dialogo. 

Annulla Rifiuta le impostazioni e chiude il dialogo. 

Guida Apre la guida online 

ORDINA COLONNE 

Le colonne possono essere ordinate a piacimento. Avete due possibilità di far ciò: 

1. nel dialogo Colonne-Proprietà facendo uso del pulsanteVerso l´alto e Verso il basso. 

2. Nella visuale dettagliata del manager di progetto per Drag&Drop usando il mouse: 

 Cliccate con il mouse nel titolo colonna desiderato. 

 Tenete premuto il tasto sinistro del mouse. 

 Trascinate il titolo colonna nella posizione desiderata. Due frecce rosse segnano il 

posto nel quale viene inserita la colonna. 

 Posizionate la colonna rilasciando il tasto del mouse. 
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9.2.8 Proprietà colonne 
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Parametri Descrizione 

Colonne disponibili Lista delle colonne disponibili facendo uso della Selezione colonne. La 

colonna selezionata in questa sede viene configurata mediante le proprietà 

della sezione Parametri. 

Parametri Impostazioni per colonna selezionata. 

Descrizione Nome del titolo della colonna Il titolo colonna è traducibile online. A tal scopo 

dovete inserire il carattere @ prima del nome. 

Larghezza Larghezza della colonna in caratteri.  

Calcolo: numero per larghezza media del carattere selezionato. 

Orientamento Orientamento.  

Impostazioni possibili: 

 Orientamento a sinistra: nella colonna, il testo si dispone prendendo a 

riferimento il bordo sinistro. 

 Centrato: nella colonna, il testo si dispone in posizione centrale. 

 Orientato a destra: nella colonna, il testo si dispone prendendo a riferimento il 

bordo destro. 

Blocca filtro 

colonne a Runtime 

Attiva:  Il filtro per questa colonna non può essere modificato durante il 

Runtime. 

 disponibile solo per: 

 Batch Control 

 Trend esteso 

 Message-Control 

 Manager gruppi di ricette 

OK Riprende le impostazioni e chiude il dialogo. 

Annulla Rifiuta le impostazioni e chiude il dialogo. 

Guida Apre la guida online 
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9.3 File 

Dei file esterni possono essere integrati in un progetto facendo uso del nodo File del Manager di 

progetto. Per modificare dei file esterni, deve essere disponibile un programma adatto a questo scopo. 

Ciò significa: potete implementare, per esempio, un video. Per modificarlo, però, dovete disporre del 

software necessario. zenon amministra solo questi file. 

Sono disponibili i seguenti file esterni:  

 Grafica (auf Seite 110)  

 Guida (auf Seite 112)  

 Multimedia (auf Seite 114)  

 Liste (auf Seite 116) 

 Driver (auf Seite 118)  

 Report Viewer (auf Seite 121) 

 Altri (auf Seite 122) 

SOTTOCARTELLA 

In corrispondenza del nodo Help, Liste, Multimedia e Altro è possibile impostare delle sottocartelle. A tal 

scopo, usate il comando Nuova cartella che trovate nel menu contestuale. Con l´aiuto di sottocartelle, potete 

usare anche su documenti cambi lingua durante il runtime.  

  Attenzione 

Le sottocartelle possono essere usate solamente per organizzare il cambio lingua.  Tutti 

gli altri elementi, come grafiche, file multimedia, ecc., debbono essere salvati sempre nel 

livello superiore della cartella, perché non sono accessibili per zenon se si trovano in 

sottocartelle.  
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MENU 

Punto di menu Azione 

Importa file grafico Apre il Manager file che serve alla selezione di un file. 

Importa tabella lingua Apre il Manager file che serve alla selezione di un file. 

Importa file help Apre il Manager file che serve alla selezione di un file. 

Importa file multimediale Apre il Manager file che serve alla selezione di un file. 

Importa file lista Apre il Manager file che serve alla selezione di un file. 

Importa file driver Apre il Manager file che serve alla selezione di un file. 

Importa modello report Apre il Manager file che serve alla selezione di un file. 

Importa altri tipi di file Apre il Manager file che serve alla selezione di un file. 

Help Attiva la guida online 

 

 

9.3.1 Grafica 

I file grafici per le grafiche di sfondo o gli elementi dinamici. Sono disponibili i seguenti formati: 

 *.bmp 

 *.gif  

 *.jpg  

 *.png 

 *.wmf 

 *.XAML  disponibile solo per elemento WPF! I file XAML dispongono di 

un´anteprima nella visualizzazione dettagliata! 
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MENU 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Nuova cartella Aggiunge una nuova sottocartella. 

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in 

proprio. 

Elimina cartella Cancella la cartella selezionata, che è stata creata in proprio, dopo la 

richiesta di conferma. 

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 79) predefiniti. 

Guida Attiva la guida online 

 
 

Grafiche Barra simboli e menu contestuale 
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MENU CONTESTUALE GRAFICHE 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Modifica file esterni Apre il sistema operativo come programma definito di default per la 

modifica del file selezionato. 

Modifica file esterni con Apre una lista di programma adatti alla modifica del file selezionato 

Copiare Copia gli inserimenti selezionati negli appunti 

Inserisci Aggiunge il contenuto degli appunti. Se un inserimento è già esistente 

con lo stesso nome, il contenuto viene aggiunto come "copia di". 

Elimina Cancella gli inserimenti selzionati. 

Modifica celle 

selezionate 
Apre la cella selezionata per effettuarne la modifica Vedete quale cella 

è stata selezionata in una riga evidenziata facendo riferimento al 

simbolo della lente di ingrandimento nella riga titolo. 

Sostituisci testo nella 

colonna selezionata... 
Apre il dialogo che serve alla ricerca e alla sostituzione di testi. 

Proprietà Apre la finestra Impostazioni per l´inserimento selezionato. 

Rimuovi tutti i filtri Elimina tutte le impostazioni di filtro 

Guida Attiva la guida online 

 

 

9.3.2 Guida 

Cartella per file guida per la guida runtime del progetto Questi file vengono salvati in formato *.chm. 
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MENU 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Nuova cartella Aggiunge una nuova sottocartella. 

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in 

proprio. 

Elimina cartella Cancella la cartella selezionata, che è stata creata in proprio, dopo la 

richiesta di conferma. 

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 79) predefiniti. 

Guida Attiva la guida online 

 

 

Guida Barra simboli e menu contestuale 
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MENU CONTESTUALE GUIDA 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Modifica file esterni Apre il sistema operativo come programma definito di default per la 

modifica del file selezionato. 

Modifica file esterni con Apre una lista di programma adatti alla modifica del file selezionato 

Copiare Copia gli inserimenti selezionati negli appunti 

Inserisci Aggiunge il contenuto degli appunti. Se un inserimento è già esistente 

con lo stesso nome, il contenuto viene aggiunto come "copia di". 

Elimina Cancella gli inserimenti selzionati. 

Modifica celle 

selezionate 
Apre la cella selezionata per effettuarne la modifica Vedete quale cella 

è stata selezionata in una riga evidenziata facendo riferimento al 

simbolo della lente di ingrandimento nella riga titolo. 

Sostituisci testo nella 

colonna selezionata... 
Apre il dialogo che serve alla ricerca e alla sostituzione di testi. 

Proprietà Apre la finestra Impostazioni per l´inserimento selezionato. 

Rimuovi tutti i filtri Elimina tutte le impostazioni di filtro 

Guida Attiva la guida online 

 

 

9.3.3 Multimedia 

File audio e video possono essere integrati nei seguenti formati: 

 *.avi 

 *.mp3 

 *.mpeg 

 *.wav 

Tenete presente il fatto che, per eseguire questi file sul computer runtime, devono essere disponibili i 

corrispondenti Codecs.  
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MENU 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Nuova cartella Aggiunge una nuova sottocartella. 

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in 

proprio. 

Elimina cartella Cancella la cartella selezionata, che è stata creata in proprio, dopo la 

richiesta di conferma. 

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 79) predefiniti. 

Guida Attiva la guida online 

 
 

Multimedia Barra simboli e menu contestuale 
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MENU CONTESTUALE MULTIMEDIA 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Modifica file esterni Apre il sistema operativo come programma definito di default per la 

modifica del file selezionato. 

Modifica file esterni con Apre una lista di programma adatti alla modifica del file selezionato 

Copiare Copia gli inserimenti selezionati negli appunti 

Inserisci Aggiunge il contenuto degli appunti. Se un inserimento è già esistente 

con lo stesso nome, il contenuto viene aggiunto come "copia di". 

Elimina Cancella gli inserimenti selzionati. 

Modifica celle 

selezionate 
Apre la cella selezionata per effettuarne la modifica Vedete quale cella 

è stata selezionata in una riga evidenziata facendo riferimento al 

simbolo della lente di ingrandimento nella riga titolo. 

Sostituisci testo nella 

colonna selezionata... 
Apre il dialogo che serve alla ricerca e alla sostituzione di testi. 

Proprietà Apre la finestra Impostazioni per l´inserimento selezionato. 

Rimuovi tutti i filtri Elimina tutte le impostazioni di filtro 

Guida Attiva la guida online 

 

 

9.3.4 Liste 

Testi e formati sono:  

 File di testo per la visualizzazione nel progetto 

Fine file: .txt 

 File di formattazione per la formattazione di stampe 

Fine file: .frm 

 File HTML per la visualizzazione in immagini HTML 

Fine file: .htm oppure .html 
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MENU 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Nuova cartella Aggiunge una nuova sottocartella. 

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in 

proprio. 

Elimina cartella Cancella la cartella selezionata, che è stata creata in proprio, dopo la 

richiesta di conferma. 

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 79) predefiniti. 

Guida Attiva la guida online 

 
 

Testi e formati Barra simboli e Menu contestuale 
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MENU CONTESTUALE TESTI E FORMATI 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Modifica file esterni Apre il sistema operativo come programma definito di default per la 

modifica del file selezionato. 

Modifica file esterni con Apre il file selezionato nell´editor standard del formato file, oppure 

offre una selezone di editor adatti. 

Copiare Copia gli inserimenti selezionati negli appunti 

Inserisci Aggiunge il contenuto degli appunti. Se un inserimento è già esistente 

con lo stesso nome, il contenuto viene aggiunto come "copia di". 

Elimina Cancella gli inserimenti selzionati. 

Modifica celle 

selezionate 
Apre la cella selezionata per effettuarne la modifica Vedete quale cella 

è stata selezionata in una riga evidenziata facendo riferimento al 

simbolo della lente di ingrandimento nella riga titolo. 

Sostituisci testo nella 

colonna selezionata... 
Apre il dialogo che serve alla ricerca e alla sostituzione di testi. 

Proprietà Apre la finestra Impostazioni per l´inserimento selezionato. 

Rimuovi tutti i filtri Elimina tutte le impostazioni di filtro 

Guida Attiva la guida online 

 

 

9.3.5 Driver 

I file driver possono essere integrati nei seguenti formati: 

 *.cfg  

 *.iso 

 *.tcp 

 *.bur 

 *.fms 

 *.bec 
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 *.ovd 

 *.nmp 

 *.ini  

 *.h11 

 *.lst 

 *.dde 

 *.lon 

 *.opc 

 *.ecs 

Normalmente, qui ci si può risparmiare l´inserimento. I file vengono automaticamente generati al 

momento della installazione del driver e salvati in questa sede. 

MENU 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Nuova cartella Aggiunge una nuova sottocartella. 

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in 

proprio. 

Elimina cartella Cancella la cartella selezionata, che è stata creata in proprio, dopo la 

richiesta di conferma. 

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 79) predefiniti. 

Guida Attiva la guida online 

 
 

Driver Barra simboli e menu contestuale 
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MENU CONTESTUALE DRIVER 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Modifica file esterni Apre il sistema operativo come programma definito di default per la 

modifica del file selezionato. 

Modifica file esterni con Apre una lista di programma adatti alla modifica del file selezionato 

Copiare Copia gli inserimenti selezionati negli appunti 

Inserisci Aggiunge il contenuto degli appunti. Se un inserimento è già esistente 

con lo stesso nome, il contenuto viene aggiunto come "copia di". 

Elimina Cancella gli inserimenti selzionati. 

Modifica celle 

selezionate 
Apre la cella selezionata per effettuarne la modifica Vedete quale cella 

è stata selezionata in una riga evidenziata facendo riferimento al 

simbolo della lente di ingrandimento nella riga titolo. 

Sostituisci testo nella 

colonna selezionata... 
Apre il dialogo che serve alla ricerca e alla sostituzione di testi. 

Proprietà Apre la finestra Impostazioni per l´inserimento selezionato. 

Rimuovi tutti i filtri Elimina tutte le impostazioni di filtro 

Guida Attiva la guida online 
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9.3.6 Report Viewer 

I modelli di report sono dei file in formato RDL 2.0, che possono essere aperti, visualizzati e modificati in zenon 

Report Viewer. 

MENU 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un Report File di 

definizione. 

Nuova cartella Aggiunge una nuova sottocartella. 

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in 

proprio. 

Elimina cartella Cancella la cartella selezionata, che è stata creata in proprio, dopo la 

richiesta di conferma. 

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 79) predefiniti. 

Guida Attiva la guida online 

 disponibile solamente se si possiede una licenza per il Generatore di rapporti e il Report Viewer.  

Non disponibile se l´opzione Progetto WindowsCE (proprietà di progetto Generale) è attiva.  

 

Report Viewer; barra dei simboli e menu contestuale 
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MENU CONTESTUALE; MODELLI REPORT 

Punto di menu Azione 

Report; Nuovo file di definizione Crea un nuovo file RDL sulla base di default.rdl.   

Report; apri file di definizione Apre il software connesso ai file RFL al fine di modificare un 

file di definizione esistente. 

Di default, zenon cerca anzitutto il MS Report Builder,  poi il 

MS Report Designer. 

Torna all'elemento di partenza Nell´ambito degli elementi collegati, ritorna a quello partendo 

dal quale si era passati al modello report. 

Questo comando è presente nel menu contestuale solamente 

se ci sono degli elementi collegati. 

Copiare Copia gli inserimenti selezionati negli appunti 

Inserisci Aggiunge il contenuto degli appunti. Se un inserimento è già 

esistente con lo stesso nome, il contenuto viene aggiunto 

come "copia di". 

Elimina Cancella gli inserimenti selzionati. 

Importa file di definizione Report 

esistente 
Apre il dialogo che serve ad importare un file di definizione 

Report già esistente. Questi file devono essere del tipo RDL 

2.0. 

Rimuovi tutti i filtri Elimina tutte le impostazioni di filtro 

Modifica celle selezionate Apre la cella selezionata per effettuarne la modifica Vedete 

quale cella è stata selezionata in una riga evidenziata facendo 

riferimento al simbolo della lente di ingrandimento nella riga 

titolo. 

Sostituisci testo nella colonna 

selezionata... 
Apre il dialogo che serve alla ricerca e alla sostituzione di testi. 

Proprietà Apre la finestra Impostazioni per l´inserimento selezionato. 

Guida Attiva la guida online 

 

 

9.3.7 Altri 

Cartella per salvare qualsiasi tipo di file. 
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MENU 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Nuova cartella Aggiunge una nuova sottocartella. 

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in 

proprio. 

Elimina cartella Cancella la cartella selezionata, che è stata creata in proprio, dopo la 

richiesta di conferma. 

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 79) predefiniti. 

Guida Attiva la guida online 
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Barra simboli Altro e menu contestuale 

MENU CONTESTUALE ALTRO 

Punto di menu Azione 

Inserisci file Apre il Manager file che serve alla selezione di un file. 

Modifica file esterni Apre il sistema operativo come programma definito di default per la 

modifica del file selezionato. 

Modifica file esterni con Apre una lista di programma adatti alla modifica del file selezionato 

Copiare Copia gli inserimenti selezionati negli appunti 

Inserisci Aggiunge il contenuto degli appunti. Se un inserimento è già esistente 

con lo stesso nome, il contenuto viene aggiunto come "copia di". 

Elimina Cancella gli inserimenti selzionati. 

Modifica celle 

selezionate 
Apre la cella selezionata per effettuarne la modifica Vedete quale cella 

è stata selezionata in una riga evidenziata facendo riferimento al 

simbolo della lente di ingrandimento nella riga titolo. 

Sostituisci testo nella 

colonna selezionata... 
Apre il dialogo che serve alla ricerca e alla sostituzione di testi. 

Proprietà Apre la finestra Impostazioni per l´inserimento selezionato. 

Rimuovi tutti i filtri Elimina tutte le impostazioni di filtro 

Guida Attiva la guida online 

 

 

9.4 Libreria simboli globale 

zenon fornisce tramite la Libreria simboli globale delle grafiche proprie, predefinite.  Mentre i 

simboli nella cartella Immagini sono a disposizione solamente per l´immagine attuale, quelli della 

libreria simboli globale possono essere utilizzati in ogni progetto.   

Possono essere anche impostati dei simboli proprio, o riassunti o collegati.  I dettagli relativi li potete 

trovare nel capitolo Immagini / Simboli 

L'Editor salva lo stato della cartella simboli (aperta o chiusa), anche quando si lascia la biblioteca dei 

simboli o si chiude l'Editor.  
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9.5 Dialoghi di selezione 

In zenon ci sono a disposizione dialoghi appositi e liste fitrate per la selezione di determinati elementi.  

Essi sono gli stessi in tutto il sistema e tengono presenti i progetti attuali e i loro sottoprogetti. Sono a 

disposizione per:   

 Utente 

 Immagini 

 File 

 Tipi di dato 

 Funzioni 

 Modelli 

 Driver 

 Variabili 

Potete leggere le informazioni dettagliate concernenti le visualizzazioni nel capitolo Visualizzazione 

dettagli del Manager di progetto (auf Seite 92); trovate delle informazioni concernenti il filtraggio nel 

sottocapitolo Filtra inserimenti lista (auf Seite 100). 

Trovate delle informazioni dettagliate concernenti i dialoghi di selezione per funzioni e variabili, nonché 

la sostituzione di funzioni e variabili già selezionate nei sottocapitoli:  

 Funzioni (auf Seite 126) 

 Variabili (auf Seite 127) 
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9.5.1 Funzioni Dialogo di selezione 

Al fine di selezionare delle funzioni, viene aperto un dialogo filtrato: 

 

Elemento Descrizione 

Albero di progetto Definizione del progetto dal quale deve essere selezionata la funzione. 

Finestra di selezione Selezione della funzione. 

Nessuna selezione A seconda dell´elemento: 

 il dialogo viene chiuso; 

 le funzioni già collegate vengono cancellate.  

 la grandezza di questo dialogo è modificabile. La grandezza e la posizione del dialogo 

viene salvata. 

MODIFICA FUNZIONI COLLEGATE 

1. manualmente 

 aprite le funzioni nella Visualizzazione dettagli (auf Seite 90) del manager di 

porgetto.  
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 trascinate la funzione desiderata sull´elemento tenendo il tasto sinistro del mouse 

premuto 

 La funzione esistente viene sostituita dalla nuova. 

2. automatico 

 selezionate nel menu contestuale dell´elemento Sostituisci collegameneti. Dettagli 

concernenti la procedura da adottare, li trovate nel capitolo Sostituzione di variabili e 

funzioni negli elementi dinamici. 
 

9.5.2 Dialogo selezione variabili 

Al fine di selezionare delle variabili, viene aperto un dialogo filtrato: 

 la grandezza di questo dialogo è modificabile. La grandezza e la posizione del dialogo 

viene salvata. 

Le variabili possono anche essere utilizzate contemporaneamente per diversi progetti. 
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COLLEGAMENTO DI UNA VARIABILE 

Gli elementi che possono essere collegati solamente con una singola variabile, aprono il seguente 

dialogo: 
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Elemento Descrizione 

Albero di progetto Definizione del progetto dal quale deve essere selezionata la variabile. 

Finestra di selezione Selezione della variabile che deve essere collegata. Il collegamento può essere 

realizzato in due modi:  

 cliccando due volte sulla variabile desiderata. In questo caso, il 

dialogo viene chiuso automaticamente. 

 Con la selezione della variabile desiderata e con la conferma 

realizzata cliccando su OK. 

Nessuna selezione A seconda dell´elemento: 

 il dialogo viene chiuso; 

 Le variabili già collegate vengono disconnesse (per es. variabili charge 

collegate nel server archivi). 

 

 se la variabile desiderata non viene visualizzata, ciò può dipendere da diverse cause:  

 avete selezionato un filtro e la variabile desiderata non corrisponde a questo filtro:  Controllate 

se nella riga filtro è inserito un filtro.  L´informazione sugli elementi filtrati inserita sotto la 

finestra di selezione è un ulteriore aiuto per il controllo dei filtri impostati.  

 Il dialogo viene aperto filtrato dall´editor e la variabile non corrisponde a questo filtro.  

L´apertura filtrata si verifica se sono ammissibili solo determinati tipi di dato, come, per esempio, 

se non possono essere collegate delle variabili string in corrispondenza ad un elemento dinamico 

Valore numerico.  

 Avete selezionato il progetto sbagliato nella struttura ad albero.  

 

  Attenzione 

Generalmente il dialogo permette la selezione di più variabili facendo uso delle 

combinazoni di tasti comuni di Windows, ma in questo stadio si può collegare solamente 

una variabile. Nel caso di una selezione multipla, solo la prima variabile selezionata viene 

attribuita all´elemento. 
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COLLEGAMENTO DI PIÙ VARIABILI.  

Gli elementi che possono essere collegati con più variabili, aprono il seguente dialogo: 
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Elemento Descrizione 

Albero di progetto Definizione del progetto dal quale deve essere selezionata la variabile. 

Finestra di selezione Selezione variabili in base a: 

 cliccando due volte, la variabile selezionata viene aggiunta alla lista 

variabili. 

 Con Drag&Drop, la variabile selezionata può essere trascinata nella 

lista variabili. 

 Selezionare le variabili desiderate. Con l´aiuto del tasto Ctrl-  

oppure di quello Shift è possibile selezionare allo stesso tempo più 

variabili. Cliccando su Aggiungi,le variabili selezionate vengono 

riprese nella lista variabili. 

Lista variabili Ordina tutte le variabili selezionate in una lista. 

Aggiungi Aggiunge la variabile attualmente selezionata nella finestra di selezione alla 

lista variabili. 

Rimuovi Rimuove la variabile selezionata nella lista variabili dalla lista. 

Nessuna selezione A seconda dell´elemento: 

 il dialogo viene chiuso; 

 determinati collegamenti, come variabili charge nell´archiviazione, 

possono essere sciolte. 

 se la variabile desiderata non viene visualizzata, ciò può dipendere da diverse cause:  

 avete selezionato un filtro e la variabile desiderata non corrisponde a questo filtro:  Controllate 

se nella riga filtro è inserito un filtro.  L´informazione sugli elementi filtrati inserita sotto la 

finestra di selezione è un ulteriore aiuto per il controllo dei filtri impostati.  

 Il dialogo viene aperto filtrato dall´editor e la variabile non corrisponde a questo filtro.  

L´apertura filtrata si verifica se sono ammissibili solo determinati tipi di dato, come, per esempio, 

se non possono essere collegate delle variabili string in corrispondenza ad un elemento dinamico 

Valore numerico.  

 Avete selezionato il progetto sbagliato nella struttura ad albero.  

  
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MODIFICA VARIABILE COLLEGATA 

Selezionate nel menu contestuale dell´elemento Sostituisci collegameneti. Dettagli concernenti la 

procedura da adottare, li trovate nel capitolo Sostituzione di variabili e funzioni negli elementi dinamici. 

 

9.5.3 Modelli 

Nel dialogo di selezione Modelli  si può procedere alla selezione di modelli per l´esecuzione di funzioni; 

essi provengono da: 

 progetto attuale 

 sotto-progetti 

 tutti i progetti del workspace con l´opzione Mantieni progetto in memoria attiva  
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Parametri Descrizione 

Finestra Albero di progetto Mostra tutti i progetti del workspace Si può procedere 

alla scelta di modelli selezionandoli tra quelli del progetto 

attuale, o fra quelli di tutti i progetti in cui l´opzione 

Mantieni progetto in memoria sia attiva 

Finestra Modelli Selezione dei modelli.  

Se selezionate diversi modelli, il sistema usa il primo 

modello scelto per l´esecuzione della funzione. 

Proponi dialogo a Runtime Apre durante il Runtime questo dialogo di selezione 

modelli nel corso dell´esecuzione della funzione.  

Nessuna selezione Non ha nessuna funzione per questa selezione di modelli. 

Scrolla sul monitor Attiva: Durante il Runtime appaiono delle barre di 

scorrimento che Vi permettono di effettuare lo scroll. 

Questa opzione è a disposizione solamente nei Sistemi 

multi-monitor. 

Monitor Selezione del monitor fra quelli della lista a cascata 

Essa contiene: 

 Monitor attuale 

 tutti i monitor virtuali definiti nella gestione monitor  

opzionale: Tutti i monitor  

Questa opzione è a disposizione solamente nei Sistemi 

multi-monitor. 

OK Riprende le impostazioni e chiude il dialogo.  

Annulla Annulla tutte le modifiche e chiude il dialogo. 

Guida Attiva la guida online  

 

 

9.5.4 File 

Nel dialogo di selezione file possono essere selezionati in una visualizzazione filtrata i file del progetto 

attuale o di progetti subordinati: 
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 Per selezionare un file di un progetto, lo si deve trovare nel nodo File/Grafiche (auf Seite 109) che si trova nel 

manager di progetto.   

 Per selezionare un file direttamente da una qualsiasi cartella del computer, si deve attivare la proprietà Selezione 

file diretta. 

 

9.5.5 Immagini 

Nel dialogo di selezione "Immagini" si può procedere alla selezione di immagini per l´esecuzione di 

funzioni; tali immagini provengono da: 

 progetto attuale 

 sotto-progetti 

 tutti i progetti del workspace con l´opzione Mantieni progetto in memoria attiva  
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Parametri Descrizione 

Finestra Albero di progetto Mostra tutti i progetti del workspace Si può procedere 

alla scelta di immagini selezionandole tra quelle del 

progetto attuale, o fra quelle di tutti i progetti in cui 

l´opzione Mantieni progetto in memoria sia attiva 

Finestra Immagini Scelta dell´immagine  

Se selezionate diverse immagini, il sistema usa la prima 

immagine scelta per l´esecuzione della funzione. 

Proponi dialogo a Runtime Apre durante il Runtime questo dialogo di selezione 

immagini nel corso dell´esecuzione della funzione.  

Nessuna selezione Non ha nessuna funzione per questa selezione 

d´immagine. 

Scrolla sul monitor Attiva: Durante il Runtime appaiono delle barre di 

scorrimento che Vi permettono di effettuare lo scroll. 

Questa opzione è a disposizione solamente nei Sistemi 

multi-monitor. 

Monitor Selezione del monitor fra quelli della lista a cascata 

Essa contiene: 

 Monitor attuale 

 tutti i monitor virtuali definiti nella gestione monitor 

 opzionale: Tutti i monitor  

Questa opzione è a disposizione solamente nei Sistemi 

multi-monitor. 

Questa opzione è a disposizione solamente nei Sistemi 

multi-monitor. 

OK Riprende le impostazioni e chiude il dialogo.  

Annulla Annulla tutte le modifiche e chiude il dialogo. 

Guida Attiva la guida online  
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9.5.6 Immagini filtro 

Se si passa ad un´immagine con filtro per altre immagini (filtro AML, filtro CEL), si apre un dialogo che 

serve a quanto segue: 

 immagine che apre 

 Immagine da attualizzare 

SELEZIONE IMMAGINE IMMAGINE CHE APRE 
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Parametri Descrizione 

Finestra Albero di progetto Mostra il progetto attuale.  

Si possono selezionare delle immagini fra quelle 

contenute in questo progetto. 

Finestra Immagini Selezione dell´immagine.  

Se selezionate più immagini, il cambio porterà 

all´immagine scelta per prima. 

Nessuna selezione Non ha nessuna funzione per questa selezione 

d´immagine. 

OK Riprende le impostazioni e chiude il dialogo.  

Annulla Annulla tutte le modifiche e chiude il dialogo. 

Guida Attiva la guida online  

SELEZIONE IMMAGINE IMMAGINE DA ATTUALIZZARE 
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Parametri Descrizione 

Finestra Albero di 

progetto 
Mostra il progetto attuale.  

Si possono selezionare delle immagini fra quelle contenute in questo 

progetto. 

Finestra Immagini Selezione delle immagini.  

E' possibile una selezione multipla. Potete aggiungere altre immagini 

cliccando due volte o facendo uso del pulsante Aggiungi. 

Finestra Selezione Ordina tutte le immagini selezionate. 

Aggiungi Aggiunge gli elementi selezionati alla finestra di selezione. 

Rimuovi Cancella gli elementi selezionati dalla finestra di selezione. 

Nessuna selezione Rimuove tutte le immagini attualmente collegate.  

OK Riprende le impostazioni e chiude il dialogo.  

Annulla Annulla tutte le modifiche e chiude il dialogo. 

Guida Attiva la guida online  
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9.5.7 utente 

Selezione di utenti del progetto attivo, di tutti i sottoprogetti e del progetto globale. 

 

Parametri Descrizione 

Lista Workspace Visualizzazione e selezione dei progetti i cui utenti possono essere 

selezionati.  

Lista Utenti Visualizzazione degli utenti del progetto selezionato. Si può filtrare 

questa lista. 

Nessuna selezione Un utente già selezionato viene deselezionato. 

OK Riprende e accetta le modifiche e chiude il dialogo. 

Annulla Rifiuta le modifiche e chiude il dialogo. 

Guida Apre la guida online 

 

 

9.5.8 Driver 

Nel dialogo di selezione driver possono essere selezionati in una visualizzazione filtrata i driver del 

progetto attuale o di progetti subordinati. 
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9.5.9 Tipi di dato 

Nel dialogo di selezione tipi di dato possono essere selezionati in una visualizzazione filtrata i tipi di dato 

del progetto attuale o di progetti subordinati. 

 

10. Finestra principale 

Nella finestra principale vengono visualizzati e modificati documenti come immagini, report e così via. La 

finistra principale è l´unica finestra che non può essere nascosta. 

APRIRE PARALLELAMENTE PIÙ DOCUMENTI. 

Potete visualizzare nella finestra principale più immagini nello stesso tempo. Potete attivare questa 

funzione tramite: Opzioni >  Finestra principale con schede . Le immagini sono raggiungibili mediante tab che 

si trovano sul bordo superiore della finestra principale e possono essere ordinate nel punto di menu 

Finestra.  

Per chiudere delle immagini aperte, usate la combinazione di tasti Ctrl + F4, il menu contestuale 

oppure il comando Chiudi > Finestra. 

MENU CONTESTUALE DOCUMENTI 

Cliccando con il tasto destro del mouse sul tab di un documento si apre un menu contestuale: 

Parametri Descrizione 

Salva Salva il documento. 

Esci Chiude questo documento. 

Chiudi tutte Chiude tutti gli altri documenti. 

POSIZIONA ELEMENTI NELL´IMMAGINE 

Attivate gli elementi con un clic sul simbolo nella Barra dei simboli Elementi (auf Seite 42) e trascinateli 

con il mouse nella finestra principale.  

Per muovere l´elemento, avete le seguenti possibilità: 
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 Muovere velocemente: cliccare sull´elemento e posizionarlo con il mouse. 

 Posizionare esattamente: cliccare sull´elemento e posizionarlo con i tasti di direzione (con le 

frecce). 

 Gira: girare l´elemento a piacere tenendolo per l´angolo in alto a sinistra.  

 

 

11. Finestra proprietà 

Nella finestra delle proprietà vengono visualizzati i parametri e le proprietà degli oggetti che sono stati 

selezionati nella sezione lista del manager di progetto, oppure degli elementi che sono stati selezionati 

nell'immagine. Nella finestra delle proprietà, inserite i valori e i parameteri per oggetti e elemento 

selezionati oppure modificateli.  

Quelle concernenti il modo di visualizzazione, l'ordinamento ed i favoriti, vengono salvati per il nuovo 

avvio dell'editor. Modificando delle proprietà di elementi nella finestra delle proprietà, viene selezionata 

automaticamente l'ultima proprietà modificata nel momento in cui si seleziona un nuovo elemento.  

SELEZIONE MULTIPLA 

Se selezionate parallelamente più oggetti (selezione multipla), tutte le proprietà che sono differenti 

negli elementi selezionati, vengono rappresentate nella finestra delle proprietà in color arancione, 

oppure evidenziate in colore rosso. Le proprietà dell´ultimo elemento selezionato vengono visualizzate: 

Nella visuale Visuale raggruppata (auf Seite 144) e in Tutte le proprietà (auf Seite 146) si può 

trasmettere la proprietà desiderata a tutti gli oggetti selezionati pigiando il testo Invio. (Ciò non è 

possibile nella Opzione dialogo (auf Seite 145).) 

  Esempio 

Sono selezionati diversi oggetti caratterizzati da differenti colori di riempimento.  

L´ultimo elemento selezionato è caratterizzato dal colore di riempimento verde. La 

proprietà Colore di sfondo verrà visualizzata in verde e il valore #32CD32 è evidenziato 

in rosso . Cliccando sul campo di inserimento e pigiando il tasto Invio si trasmette la 

proprietà verde a tutti gli elementi selezionati.  
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GESTIONE FUNZIONAMENTO DA TASTIERA  

Si può navigare nelle proprietà anche con la tastiera: 

Tasto Funzione 

Tab oppure Su Passa alla proprietà successiva. 

Shift+Tab oppure 

Giù 

Passa alla proprietà precedente. 

Enter oppure A 

destra 

Apre un nodo. 

A sinistra Salta un nodo. 

Pos 1 Torna al primo nodo 

Fine Torna all´ultimo nodo 

BARRA SIMBOLI 

Le proprietà di un oggetto vengono visualizzate e modificate nella finestra delle proprietà. Per 

organizzare la finestra delle porprietà è a Vostra disposizione una barra di simboli: 
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Simbolo 

(da sinistra a destra) 

Funzione 

Visualizzazione a 

gruppi (auf Seite 

144)  

(default) 

Tutte le proprietà dell´oggetto selezionato vengono raggruppate secondo 

un criterio logico e i gruppi vengono ordinati o in ordine alfabetico 

oppure in modo logico. Attraverso il menu contestuale possono essere 

aggiunti o eliminati inserimenti dai Favoriti.  

 Le indicazioni del manuale sulle proprietà 

partono sempre dalla visualizzazione a gruppi.. I contenuti dei gruppi 

corrispondono quelli della Visuale a dialogo. 

Tutte le 

proprietà (auf 

Seite 146)  

Tutte le proprietà dell'oggetto selezionato vengono rappresentate in una 

lista. Attraverso il menu contestuale possono essere aggiunti o eliminati 

inserimenti dai Favoriti.  

Vista a dialogo 

(auf Seite 145)  

Tutte le proprietà vengono riassunte in modo logico come nei Gruppi 

di rappresentazione e i gruppi sono ordinati secondo la 

frequenza e la priorità del loro uso. In questa visualizzazione non possono 

essere definiti dei favoriti. 

Mostra/nascondi i 

favoriti (auf Seite 146) 

Mostra o nascondo nelle visuali  Gruppi di rappresentazione 

oppure  Tutte le proprietà il nodo Favoriti.  In esso sono 

raccolte quelle proprietà che vengono utilizzate più frequentemente.  

Di default vengono proposti dei favoriti.  

Aggiungi o cancella dai favoriti degli inserimenti:  Ciò accade mediante il 

menu contestuale 'Aggiungi ai favoriti', o mediante Drag&Drop 

delle proprietà nella lista dei favoriti.  

La successione delle proprietà nei favoriti viene definita dal criterio di 

classificazione prescelto (ordine crescente, decrescente, logico).  

NellaVisuale di dialogo non possono essere creati dei favoriti.  

Mostra/nascondi 

tutte le 

proprietà 

Mostra o nasconde tutti i nodi nelle visuali Raggruppato e Tutte le 
proprietà 

Ordinamento 

logico  

(default) 

Mostra nelle visuali Raggruppatoe  Tutte le proprietà le proprietà 

ordinate in modo logico secondo la frequenza d´uso invece che in ordine 

alfabetico.   

Ordinamento 

crescente e 

decrescente  

Mostra nelle visuali Raggruppatoe  Tutte le proprietà le proprietà 

ordinate in ordine alfabetico crescente o decrescente.   
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Apri/chiudi tutti 

i nodi  

Apre o chiude nelle visuali Raggruppato e  Tutte le proprietàtutti i 

nodi.  

 il nodo delle proprietà attualmente selezionate rimane 

aperto cliccando su Chiudi tutti i nodi.  

Mostra guida 

delle proprietà 

(auf Seite 148) 

Mostra la guida integrata che concerne le proprietà (guida delle 

proprietà).  

Rendi disponibili 

proprietà 

Simboli: rende disponibile la Proprietà selezionata. 

Opzioni barra 

strumenti  

Cliccando sulla freccia si apre il sotto-menu: 

Attiva: viene visualizzata la barra dei simboli. 

Se non appare la barra dei simboli, la si può rendere attiva facendo uso 

del menu Opzioni -> Barre dei simboli.  

Nota: per una barra degli strumenti posizionata liberamente (sganciata 

dall´Editor), le opzioni non vengono visualizzate. .  La barra degli 

strumenti può essere chiusa cliccando sul pulsante X. 

 
 

11.1 Visualizzazione a gruppi 

La Visualizzazione a gruppi è selezionata di Default. Essa raccoglie in gruppi secondo un 

criterio logico delle proprietà che hanno tratti comuni.  

 

Tutte le proprietà possono essere visualizzate e escluse facendo uso della barra dei simboli.  
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  Informazioni 

Le indicazioni del manuale sulle proprietà partono sempre dalla visualizzazione a 

gruppi.. I contenuti dei gruppi corrispondono quelli della Visuale a dialogo. 

 

 

11.2 Vista a dialogo 

La Visualizzazione dialogo riassume le proprietà in gruppi e le presenta sotto forma di 

dialogo. 

 

Nella Visualizzazione dialogo non possono essere impostati dei favoriti e non possono essere 

nascoste delle proprietà.   
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11.3 Tutte le proprietà 

Tutte le proprietà vengono presentate dal sistema in una lista organizzata in ordine 

cronologico.  

 

Tutte le proprietà possono essere visualizzate e escluse facendo uso della barra dei simboli. 

 

11.4 Preferiti 

Le visuali Raggruppato e Tutte le proprietà dispongono di un nodo Favoriti che si trova 

nella parte superiore della finestra. Qui vengono visualizzate quelle porprietà che sono utilizzate più 

frequentemente. 

Di default vengono proposti dei favoriti. Per aggiungere dei proprio inserimenti, procedete come segue: 

 cliccate con il tasto destro del mouse sulla proprietà desiderata; 

 selezionate nel menu contestuale < Aggiungi proprietà > ai Favoriti  

 La successione delle proprietà nei favoriti viene definita dal criterio di classificazione (auf Seite 

147) prescelto (ordine crescente, decrescente, logico). 

Per eliminare degli inserimenti dai favoriti, procedete come segue: 

 cliccate con il tasto destro del mouse sulla proprietà desiderata; 

 selezionate nel menu contestuale <Elimina proprietà > dai Favoriti  
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I favoriti possono essere mostrati o nascosti facendo uso al pulsante corrispondente che si trova nella 

barra dei simboli.   

 NellaVisuale di dialogo non possono essere creati dei favoriti.  

 
 

11.5 Ordina proprietà 

Il criterio di classificazione viene definito nella barra simboli usando i pulsanti 'ordina in modo 

logico', 'ordina in modo crescente' e 'ordina in modo decrescente'. Di default le proprietà sono 

visualizzate nella classificazione logica.   C'è la possibilità di ordinarle in modo alfabetico.   

Le proprietà vengono ordinate in modo logico secondo il loro uso probabile.  Ciò è possibile però solo 

nella visuale'Raggruppato' e 'Tutte le proprietà'. 

Le proprietà vengono ordinate secondo la successione alfabetica crescente o decrescente.  Ciò è 

possibile per la la visuale Raggruppato, Tutte le proprietà e per i Favoriti.  

Nelle visualizzazioni Raggruppato e Tutte le proprietà è possibile chiudere tutti i nodi e 

riaprirli.   Il nodo delle proprietà attuali non viene chiuso se viene selezionato Chiudi tutti i 

nodi. 
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12. Guida delle proprietà 

Sotto le proprietá può essere aperta una finestra contenente la guida in linea per le proprietà.  

.   

Per aprire la guida delle proprietà: 

 selezionate nella barra simboli delle proprietà il simbolo Mostra giuda delle proprietà (sul 

margine destro) 

 

 oppure selezionate nel menu Opzioni il comando Guida delle proprietà  

 oppure cliccate con il tasto destro del mouse su una qualsiasi barra titoli e selezionate poi nel 

menu contestuale il comando Guida delle proprietà  

Per chiudere la giuda delle proprietà:  

 cliccate sulla X che si trova sul bordo destro della barra titoli.  

Al contrario di quanto accade nella guida in linea che si apre con il tasto F1, in questa forma di help 

viene descritta solamente la proprietà selezionata. Vi vengono fornite delle brevi indicazioni concernenti 

la proprietà attualmente selezionata e Vi viene fornito un link per la più esaustiva guida in linea. 
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La guida delle proprietà può essere, come tutte le altre finestre, posizionata liberamente sullo schermo. 

 
 

13. Finestra di emissione 

La finestra di emissione mostra le informazioni di stato e le segnalazioni di errore al momento dell´avvio 

dell´editor, nonché al momento della compilazione e trasmissione di un progetto. Le informazioni sono 

ordinate in diversi tipi: 

 Errore 

 Segnalazioni 
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 Messaggi 

 

Queste informazioni possono essere visualizzate e nascoste a piacere. Le impostazioni che stabiliscono 

quali informazioni devono essere visualizzate, sono conservate al momento della chiusura dell´editor e 

valgono anche per la visualizzazione delle nuove informazioni. Tuttavia non va perduta nessuna 

informazione, visto che le impostazioni hanno effetto solamente sulle modalità di visualizzazione e non 

sulla raccolta delle informazioni. 

 Nel caso in cui le segnalazioni sono nascoste, non ne viene visualizzata nessuna finché non ne 

viene ripristinata la visualizzazione. A partire da questo momento, tutte le segnalazioni tornano ad 

essere visibili. Vengono naturalmente visualizzate anche quelle segnalazioni che sono giunte nel 

frattempo. 

Le informazioni blu non possono essere nascoste, visto che si tratta di segnalazioni che concernono il 

progetto e che debbono rimanere sempre visibili. 

 

Simboli e menu contestuale offrono le stesse opzioni. I simboli significano da sinistra a destra: 



Finestra di emissione 

 

 

151 

 

 

simbolo/Inserimento 
menu contestuale 

Descrizione 

Visualizza 

errore 

Attiva: Errori vengono visualizzati in color rosso.  

Disattivata: Errori vengono nascosti.  

Lo stato selezionato può essere combinato con Avvisi eSegnalazioni e viene 

salvato al momento della chiusura dell´editor.  

Visualizza 

avvisi 

Attiva: Avvisi vengono visualizzati in color arancione.  

Non attiva: Avvisi vengono nascosti.  

Lo stato selezionato può essere combinato con Errori eSegnalazioni e viene 

salvato al momento della chiusura dell´editor.  

Visualizza 

segnalazioni 

Attiva: Segnalazioni vengono visualizzati in color nero.  

Non attiva: Segnalazioni vengono nascoste  

Lo stato selezionato può essere combinato con Errori eAvvisi e viene salvato al 

momento della chiusura dell´editor.  

Salva Salva l´intero contenuto della finestra di emissione in un file LOG. Il posto in cui 

viene salvato il file e il nome dello stesso possono essere scelti liberamente.  

Copiare Copia i testi evidenziati della finestra di emissione negli appunti. 

Elimina Cancella il completo contenuto della finestra emissione. Dopo l´esecuzione di 

questa azione non c´è più la possibilità di recuperare il contenuto cancellato della 

finestra di emissione. 

Trova Apre il dialogo che serve alla ricerca del testo all´interno della finestra di emissione.  

Guida Apre la pagina della guida in linea. 

 

  Esempio 

Cancellate il contenuto della finestra di emissione facendo uso del simbolo corrispondente oppure del 

menu contestuale e create poi i file runtime. Otterrete nella finestra di emissione le informazioni 

corrispondenti. Queste informazioni sono inserite in segnalazioni blu.  

1. Cliccate sul simbolo Segnalazioni: le segnalazioni standard (testo di color nero) vengono 

nascoste. 

2. Create ancora una volta i file runtime; le segnalazioni continuano a rimanere invisibili. 
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3. Nascondete anche la visualizzazione di Errori (rossi) e Avvisi (arancioni). 

4. Le segnalazioni blu, quelle relative al progetto, continuano ad essere visibili. 

5. Create di nuovo file runtime, e riattivate la visualizzazone delle Segnalazioni: Tutte le 

segnalazioni generate dal momento della cancellazione della finestra di emissione sono di 

nuovo visibili. 

 

 

14. Riga di stato 

La barra di stato dell´editor contiene delle informazioni che dipendono dall´oggetto selezionato; queste 

informazioni sono su: 

 

 disponibilità dell´editor. 

 Funzione del simbolo sulla quale si trova il puntatore del mouse. 

 Posizione del puntatore del mouse in immagini. 

 Tipo e nome dell´elemento attivo in un´immagine. 

 Punto di partenza (asse x/y), nonché larghezza e altezza dell´elemento attivo in un´immagine.  

Il punto 0/0 dell´asse si trova nell´angolo sinistro in alto. 

Nel caso dei report, la barra di stato è senza funzione. 
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15. Chiudi l'Editor 

Quando chiudete l´editor, il sistema provvede a controllare (come in caso di chiusura o cambio del posto 

di lavoro) tutti i progetti per verificare l´esistenza di modifiche. I progetti i cui file runtime non sono stati 

ancora generati, vengono presentati in un dialogo sotto forma di lista; il sistema propone di generarli.  

 

Parametri Descrizione 

Si Vengono generati i file runtime di tutti i progetti nella lista. Poi l´editor viene 

chiuso. 

No I file runtime non vengono generati. L´editor viene chiuso. 

Annulla I file runtime non vengono generati. L´editor non viene chiuso. 
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